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I. TUTORIALS 

IRIS Intermedia is based on the concept of hypertext, a term meaning 

non-sequential reading and writing. A hypertext-based system is both a 
reader's tool and an author's medium. It allows readers to follow trails 

between related materials and helps authors create those trails by pro­
viding a means for linking significant blocks of information together. 

IRIS Intermedia contains a variety of application programs. Each of 
these programs allows authors to create different sorts of materials 
(e.g., text, diagrams, timelines, etc.). This initial version of IRIS 
Intermedia includes four such application programs: 

1. lnterWord Text Editor 

2. lnterDraw Structured Graphics Editor 

3. Interval Timeline Editor 

4. lnterPix Bitmap Facility 

The material created with these applications can be linked together to 
form webs of related material. For example, a history instructor might 
create a web which includes the original writings of Thomas Jefferson. 

These writings might be linked to analytical articles about each work, a 
biography of Jefferson, a timeline which outlines all the significant his­

torical events that occurred before, during and after Jefferson's life, a 

collection of drawings that depict Jefferson's inventions and architec­
tural designs, a collection of bitmap photographs of Monticello and 

grounds and an annotated bibliography of related reading material. By 

using the IRIS Intermedia system and the accompanying applications, 
the instructor is able to create an exploratory world of Jefferson and his 

work. 

The two tutorials provided in this chapter serve as an introduction to 

IRIS Intermedia, touching briefly on many of the topics covered in 

more detail in later chapters. If you are already familiar with the 

Macintosh desktop and a number of applications, you may wish to skim 

the Introductory Tutorial and begin with the Advanced Tutorial. 

Depending on your prior experience using computer applications, the 

Introductory Tutorial should take you between a half an hour to an 

hour to complete and the Advanced Tutorial should take you between 

an hour and a half to two hours. 

1. Tutorials 
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1. INTRODUCTORY TUTORIAL: EXPLORING THE IRIS INTERMEDIA ENVIRONMENT 

The step-by-step instructions below will take you through a complete 
session with IRIS Intermedia. The bold type explains what you are to 
do or type and the plain type below it describes the step in greater 
detail. 

A. Starting Up the System 

4 

Since the machines which run IRIS Intermedia may vary, only 
general instructions for logging on are provided here. For help, 
consult the computer's owner's manual or ask someone already 
familiar with the operation of the machine. 

1. Log In to the computer and type "intennedia." 

After several seconds, the screen will display the IRIS Intermedia desktop. The top 
of the screen will contain a Menu Bar with seven menu titles (9Apple, File, Edit, 
Intermedia, Font, Arrange, Print). 

[ s File HH1 I ntermedia ron t fhr<1n9<~ Print 

Notice that several of the menus are black and that the others are "grayed." You 
can pull down both black (activated) and grayed (unactivated) menus, but you can 
only pick an action from an activated menu. Similarly, you can only pick a black 
(activated) item from a menu. The system highlights the relevant menus (and ac­
tions) for the application you're using. 

CJ CJ CJ CJ CJ 
ang bjh C'We demo gmoore 

CJ D m CJ ~ L.....J 

' 

Had kdu TUTORIAL Users NY Questions 

~I rc-1 I Ol12J: 

You will also see a folder window open on the screen. It contains at least one sub­
folder and may contain other icons. In the following example, the folder you will 
be using is called "TUTORIAL." The contents of the folder may differ slightly 
from the contents pictured in the illustrations that accompany this tutorial. 
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B. Examining Folders and their Contents 

1. Tutorials 

Folders in the IRIS Intermedia environment are like ordinary manila 
folders. They are used to store and organize documents. A folder may 
contain any number of documents of different types (text, graphics, 
timeline, or bitmap), and it may also contain other folders and webs 
(discussed later). When a folder is open, its contents are displayed in a 
window on the screen. When a folder is closed, the contents are hidden 
from view, and it is graphically represented by an icon that looks like a 
folder. 

1. Position the pointer over the ''TUTORIAL" folder icon with the mouse. 

You may see more than one folder icon on the screen. Roll the rn 
mouse on the desktop until the pointer is directly on top of the ~ 
folder icon called "TUTORIAL." As you see, moving the mouse 
moves the pointer on the screen. If you run out of room for the TUTORIAL 
mouse, pick it up and put it down where you have more space. 
When you pick the mouse up, the pointer does not move. 

2. Press and release the mouse button. 

The white folder turns to black when the button is clicked (pressed 
and released quickly). The icon is now said to be selected. • 
3. Position the pointer over the word "File" In the Menu Bar. 

The pointer should be on top of the word "File" in 
the upper left corner of the screen. 

4. Press and hold down the mouse button. 

The File menu pulls down and reveals an array of 
commands when you point to the menu title and 
hold down the mouse button. 

1Wdl$f!1I 

•;ii11·--
New ... 
Open 

Close 

:ICN 
XO 

xw 
t: lo~rn Dc~fini1 ion~ :•:fl 
Sa Pe x~ 

Sm1c~ fl~ ... 
H•~1rnr t 

Delete Document 

Close All Documents 
Quit XQ 
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6 

5. Point to the word "Open" in the menu without releasing the but· 
ton. 

As you move over the menu commands with the 
button depressed, the commands that can be chosen 
are highlighted in black. 

6. Release the mouse button when the word "Open" is highlighted. 

Close 
I: lose DMini1ion~ '.s(fl 
Sa Pe ~s 
Sm1e flL, 
Ht~tJNt 

Delete Document 

Close All Documents 
Quit sgQ 

The pointer will assume the shape of a wristwatch while you wait for the folder to 
open on the desktop and reveal its contents. (If this did not happen, repeat steps 1-
6.) The folder may contain other folder icons, document icons and/or web icons. 
Your screen should now resemble Figure 1. (The number and names of the icons 
you have may differ slightly from the ones pictured.) 

s File Hid lntermedia font fln<mw~ Print 

/int/docs 

~ LJ LJ CJ 
C. Dickens A Sample Web Abetracts IRIS Woiterland 

fJ ~ 
Author Timeline Droiv Example Word Example 

Figure 1. The "TUTORIAL" folder window containing document, folder and web icons. 
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7. Open the document called 'Word Example." 

Either follow steps 1-6, replacing "TUTORIAL" folder icon with "Word Example" 
document icon, or position the pointer over the "Word Example" icon and double­
click the mouse button (press and release the button quickly two times in a row). 

Selecting "Open" from the File menu when an icon is selected and double-click­
ing on that icon are equivalent to one another 

After double-clicking or picking "Open," the InterWord document named "Word 
Example" will open in a window. 

C. Repositioning and Manipulating Windows 

1. Tutorials 

Windows allow you to see the contents of folders and documents. So far, 
you have seen folder windows and a text window. Although the win­
dows differ in what they contain, they can be manipulated in similar 
ways. The steps below are intended to familiarize you with some useful 
ways to manipulate windows. Specifically, you will learn how to move 
and resize windows so that you can arrange, organize and reorganize 
your screen in any way that you wish. You will also learn scrolling 
techniques. 

Close Box Folder Name 

I I 

mm-shaft 
-Scroll Box 

11 

'-------- Left'Right Scroll Arrows--------' 
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Moving Wlldows 

1. Position the pointer over the 
words "Word Example" In the 
window's Title Bar. 

=o UJord E1utmple 

Sample lnterWord Document Q -This document we.s created using Inte.rWord, iii!il 
Inte.rmedi.a' s word processing program. As you step mm 
through this tutorial, you will notice that the sample mm 
mate.rial refers to the history of the Institute for Res ee:cch IO 

The pointer should be right 
over the text. 

K:i 1 H:m::::::::rn:::::::::Hrn:::::::rn:Hm::mrn::m::::rn::::::m:::::m:::::m:::::mmmrn::::m::::m:::n c 12:i 

2. With the mouse button depressed, move the mouse. 

The border of the window will become a bit fuzzy. You will see the outline of the 
window follow your movements. 

UJord EHample 

lnterWord Document 

This! document was created using InterWord, f! 
Inte:rme~a's word processing program. As you step mm 
through! this tutorial, you will notice that the sample mm 
material,.refer·s··;:o··th·e·"hi·st.ory··;;·f·tile.tns.nmte .. ior .. Res.e&dl. 

3. Release the mouse button. 

The window will now be in a new position. 

Resizing Wlldows 

8 

1. Position the pointer over the Re· 
size Box of the "Word Example" 
windaN. 

The Resize Box is located 
in the lower right corner of 
the window. 

Word EHample 

Sample lnterWord Document 

This document was created using Inte.rWord, filffi 
Intmnedi.a.'s word processing program. As you step ill!:! 
through this tutorial, you will notice tb.a.t the sample !!mi 
mate.rial refers to the history of the Institute for Res ee:cch O 

K;:I 1 i::::::::H::rn:::::::::::::::::::::::::::::::::::::::::::::::::::::::m:::::::::::::m::::::::::mrn:::::::::w::::::::m r.; ~' ..., 
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Scrollilg 

1. Tutorials 

2. Hold down the mouse button and 
rrove the mouse. 

An outline of the lower 
right corner of the window 
will follow your move­
ments. 

3. Release the mouse button. 

f~tf .............................. ···· 'iii·o·rci.i>ia·ffi·Ji1e -~~~~~~i 
f' ........................ s.am.pfe·····i·i1ie'?!fio.rd···i5o·c·u·m·e·nt····r···1 

l This document was created using Inte.r:lw lrd, 
Intermedia's word processing program. As yoii ~ep .,.,., 
through this tutorial, you will notice that the ~ arr;,ple mm 
material refers to the history of the Institute for Re~ e¥ch · · · 

l2J 

The window should now have assumed a new size, either larger or smaller, de­
pending on the position of the window's outline when you released the button. 

1. Cilek on the up and down arrows In the Scroll Bar to examine the contents of the Word Example document 

The contents of the document will move in and out of view in small increments as 
you experiment with the Scroll Arrows. 

2. Position the pointer over the 
Scroll Box (elevator). 

The Scroll Box located in 
the Shaft allows you to 
move to a new relative 
position in the window. For 
example, if you move the 
Scroll Box to the middle of 
the Shaft, you will scroll to 
the mid point of the doc­
ument. 

3. With the mouse button depressed, 
drag the Scroll Box to the bottom of 
the Shaft. 

An outline of the Scroll Box 
will follow your move­
ments. 

Word EHample 
Sample lnterWord Document fQ: 

::E;i:'Si:~:i·!:~~~:~::3i r_,_i·oi'!_ ... 1 .... !.1 ..• 1 .. i.1 __ ,!. 

mate.rial. re.fie.rs to the. history of the. Institute. for Re.s e.arch 
in Information and Scholarship (IRIS) or to Graham 

;o Word EHample 
Sample lnterWord Document 

::E;i:::i~~~ .. 2z::::~ ~:;3;~ :J_ .. , .. :.~ ... ·;i· ... ! ... 
1 

..... : 
mate.rial. re.fie.rs to the. history of the. Institute. for Re.search. ~ 
in Information and Scholarship (IRIS) or to Graham IO 

0 I lilJ!il!il!ii!i!i!Hiil!ill!i!i!i!W!Hl!!!iii!!ll!i!i!HW!!!!!!!H!!!ii!iii!!il!iil!iil!illiiiiii!i!HWiiili!iiiiiill!ii!iii!il Q G:!: 
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4. Release the mouse button. 

The Scroll Box will move to 
the new position in the 
Shaft and the window will 
scroll so that you are view­
ing the contents at the end 
of the document. 

5. Position the mouse above the Scroll Box. 

Be sure the pointer is in the Shaft above the Scroli Box. 

6. Click the button once. 

The contents of your window will now scroll up one screenful. Clicking in the 
Shaft above or below the Scroll Box allows you to scroll the contents of the window 
up or down by screenfuls. 

lntermedia hnt fln-<rnw~ Print 

S<WO 
S;we flL, 
HHH~!'t 

Delete Document 

8€N docs 
· 1 docs/TUTORIAL 

CJ 
Abstracts 

Close Rll Documents ord Example 
Quit 8€Q 

CJ 
IRIS 

CJ 
Waterland 

Figure 2. The File menu pulls down to reveal a list of commands. As you move over the menu commands with the mouse 
button depressed, the commands that can be chosen are highlighted. Releasing the mouse button when a command is 
highlighted (in this case "Open") issues the command. 

Introductory Tutorial: Exploring the IRIS lntermedia Environment 1. Tutorials 



1. Tutorials 

7. Close 'Word Example" by clicking once In the Close Box. 

Position the pointer over the white box in the upper left corner of the "Word Exam­
ple" window and click the mouse button once. 

Position Click 

The "Word Example" window closes, returning to its iconic representation. The 
screen will return to the way it looked after step 7 in Subsection B. If the document 
does not close, and instead you see a dialog box informing you that you do not 
have rights to change this document, simply click on the "OK" button. This means 
that you accidentally clicked in a location other than the Close Box; be sure the ar­
row is pointing right into the Close Box before you try closing the document again. 

a File f dH I ntermedia Font fln-<lnge Print 

/int/docs 

/int/docs /TUTORIRL 

~ CJ LJ 24 documents in web 

fill C. Dickens A Sample Web Abstracts IRIS !!il A Sample 'w'eb 

~ ~ 
'w'ed May 25 19 :35 :38 1 988 

~ L.....J 

Author Ti meli ne Ora..., Example Word Example 

Figure 3. The "A Sample Web" Web View window contains an open symbol, a tiny web icon and the time and date. 
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D. Opening a Web 

12 

In the IRIS Intermedia environment, documents can be viewed and 
edited in one of two ways. They can either be examined as individual 
entities or they can be looked at within a specific context called a web. 
When a web is open, you are able to jump from one document to 
another by following links. If an encyclopedia were contained in an 
environment like IRIS Intermedia, links would exist between articles 
that are traditionally connected by "See Also ... " references. Instead of 
retrieving a new volume and finding the correct page and column 
indicated in the "See Also ... " reference, the reader would be able to 
point to the words "See Also" and ask to see the referenced article in 
another window on the screen. 

The remainder of this tutorial will be devoted to exploring documents 
within the context of a sample web provided in the TUTORIAL folder. 
The advanced tutorial provides an introduction to creating your own 
web. 

1. Select the "Sample Web" web Icon. 

After clicking once on the "Sample Web" icon, it should be 
highlighted. 

2. Pick "Open" from the File menu. 

fill Figure 2 illustrates what the screen should look like now. (Remember that double­
clicking on the "Sample Web" icon is another way to open the web.) After the 
"Open" command is issued, a Web View window appears (Figure 3). It should 
contain an open symbol (shown at left), a small web icon and the time and date. 
You might want to resize the window so that it takes up less space on your desktop 
(see above for information on resizing windows). Don't worry if the Web View 
appears in a slightly different location than in the illustration - you can move it to 
the location pictured by clicking on the Title Bar and dragging the window across 
the screen (see subsection D. Repositioning and Manipulating Windows, above). 

3. Click in the "TUTORIAL" folder window. 

This activates the folder window. Now you can open one of the documents con­
tained in the web. 

4. Open the 'Word Example" document 

Either select the icon and pick "Open" from the File menu or double-click on the 
"Word Example" icon. A window containing the "Word Example" document will 
appear. 
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File Edit lntermedia Font fln dnqe 

Word £Hample 

Sample lnterWord Document 

This document was created using InterWord, 

Intermedia's word processing program. As you step 

through this tutorial, you will notice that the sample 

material refers to the history of the Institute for Research 

in Information and Scholarship (IRIS) or to Graham 

Swift's novel Water/and. 

IRIS is the organization which developed Intermedia. 

For more information on the Institute you may follow the 

link in the indented paragraph below. The link marker is 

over r.he first letter of the word "timeline." If you don't 

have a web open, you shouldn't see the ma1ker; however, 

later in t.he tutorial when you return to t.his document 

after having opened "Sample Web," you will see an arrow 

over the word Institute. 

Follow to see ~<eline of significant events in the 

life of the Institute. 

Print 

R Sample Web: Web Uiew 
39 links in web 

iii Word Example 
Wed May 25 19 :38 :40 1988 

iii Waterland 

~Retrospective 

g· 'It at.erland OV 

Figure 4. Clicking on a link marker highlights the link marker in the document and the link line in the Web View. 

s File Edit lntermedia fnn t Arrange Print 

Word £Hample 

~D RetrospectiUe 

! ..................................................... n~r:f:· ..................................................... ~ 
; A Retrospective Fosusing on lntermedia Ji 

a 
1985 ·An Electronic 'Soap Opera' 

and 'Hyper Media' back.ad by 
$3-Million CPB Grant,· -­
Chronicle of Higher Education_ 
a 
• Annenberg Foundation awards 
$1.5 million,· -- The Insiders 
Report. 
a 
•personal Computers on 
Campus,· -- Science 
a 
•Multimillion-Dollar Projects to 
Study Uses of Computers Suffer 
Setback.s on a Campuses,· -­
Chronicle of Higher Education_ 
El 
Networks of Scholar's Workstations: 
End-User Com utin in a Universit 

L 

li!!i 24 ';~~,:::~:e Web: Web3~~:: ;o ¥" 

![ii!! ~A Sample \v'eb 

::m: Thu May 26 12 :13 :55 1988 

§jJ 

~ 

ll@vord Example 
Thu May 26 1 2 : 1 4 : 1 2 1 988 

~Retrospective (Ret.rospech~e Tit.le) 
Thu May 26 1 2 : 1 4 :41 1 988 

Figure 5. The Follow command leads you to the destination of the link and opens a window containing an Interval docu­

ment. The marker and text associated with the link are highlighted in the window and the Web View updates to show the 

links to the destination document. 
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E. Following Links 
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The Sample Web contains a number of connected or linked documents. 
The existence of links in a document is indicated by link markers. In 
text documents these markers are located directly over the first char­
acter of the text associated with the link. A link marker looks like: El. 

It is possible to follow links - travel from the text or graphics associ­
ated with one end of the link to the text or graphics associated with the 
other end - by selecting the link markers. To learn how, follow the in­
structions below. 

1. Find the first link marker in the 'Word Example" window. 

Figure 4 illustrates the location of the link marker. If it is not visible on your 
screen, use the controls in the Scroll Bar to locate the marker. Figure 4 also illus­
trates the manner in which the Web View updates. As you follow links, this dia­
gram will continually update, indicating where you have been, where you are, 
and where you can go. In this case, you can see all the documents linked to "Word 
Example." If you can not see the entire contents of the Web View, click once in the 
window to activate it, and, if necessary, reposition and resize it so it fills the lower 
right portion of the screen. Reactivate the "Word Example" window by clicking 
anywhere in the window. 

2. Position the cursor over the link marker. 

~ Make sure the pointer is directly over the arrow. 

3. Click the mouse button. 

Clicking the mouse button should highlight the link marker in the document and 
the link line in the Web View. Figure 4 illustrates this in the context of the entire 
screen. 

4. Pick "Follow" from the lntermedia menu. 

The Follow command allows you to traverse the link and opens a window con­
taining another document. In this case, it leads to an InterVal or "timeline" doc­
ument called "Retrospective." Notice that a link marker and the title of the time­
line are highlighted in the new window and that the Web View has redrawn to re­
flect the links to the currently active document. See Figure 5. 
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5. Close the window called "Retrospective." 

When the window closes, the "Word Example" window will become the active 
window once again. The active window is always indicated by black stripes 
around the window title. 

If a window is not active, moving the pointer within the window's borders and 
clicking on the mouse button will activate it. 

6. Scroll through the document to find the second link marker. It should be somewhere In the fifth paragraph. 
5elect the second link marker. 

In the same way as you selected the first link marker (steps 2 and 3), select this 
one. When selected, the marker will be highlighted. 

7. Pick "Follow'' from the lntermedia menu or double-click on the marker. 

Try positioning the pointer over the link marker and double-clicking on the 
mouse button. This is exactly the same as selecting the marker and picking the 
"Follow" command from the menu. In this case, more than one link is attached to 
the text associated with the marker. A dialog box appears on your screen, asking 
you to choose a destination. Pick "Waterland OV (Overview of Topics)" by click­
ing on that item once, and then click on the "OK" button (Figure 6). The text at the 
other end of the link is part of a graphics document. See Figure 7. Always remem­
ber to wait for the cursor to change from the watch back to the arrow before contin­
uing. 

8. Experiment with following links. 

A number of practice links are contained in the "Waterland OV" document as 
well as others in the TUTORIAL folders. Try selecting a link marker and 
following the link. After you examine the contents of the documents at the ends of 
the links, close the windows containing those documents so the screen does not be­
come too cluttered. 
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j File Edit lntermedia Font fln <n~qe Print 

Word EHample 
after having opened. "Saro.ple Web," you will see an arrow I AL 
over the word Institute. rn•n1-----------

Foll 
life Please choose a source and then the destination 

Orah 
taught in 
Llteratur 

Source 

About the Nouel ~ 

Destination 

= 
Follow to obtain further informa.tion on Waterkm.d. 

Its use of a central mystery to examine the life a 
society over a long period of time is similar 

( Cancel J 

Figure 6. When more than one link is attached to the text associated with a marker, a dialog box will ask you to choose a 
destination. Here, the chosen destination is "Waterland OV (Overview of Topics). 

s File Edit I ntermedia fnn t Arrange Print 

§0 
afters:;;=-------

is 
scan 
book, 
'Wat 
be vi 

Literary Relations 

The t'.Jovel 

Tlmeline of Events 
in the Novel 

Waterland OU 

(3 rah am Sv1ift 
1983 ~ 

Other Works 

Tile Sivee/-S/'h7p Owner 
Sht1/lier.or.l 
L e.-:rm!ng lo Su4m .-:rnd C/1/78!' S!or!es 

Its use of e. central mystery to examine the life a 
society over a long period of time is similar 

History, His Story 
and Stories in 
Waterland 

Literar~· Techniques 

Figure 7. The Follow command is completed. The highlighted destination of the link appears in an lnterDraw document 
window. 
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F. Closing a Web and Exiting the System 

1. Tutorials 

Links and link markers exist only within the context of a web. lVhen a 
web is closed, the link markers created in the context of the web will no 
longer appear on the screen. If you close the documents and then re­
open them when the web is closed, the documents will appear without 
their link markers (as you saw with the "Word Example" document in 
Subsection B. of this tutorial). The links are still there, but they cannot 
be followed when the web is closed. Opening the web will not make 
markers appear in documents that are already open. You must first 
close all open documents then reopen the web in order to be able to use 
those documents within the context of the web. 

1. Close au open document and Web View windows. 

You can do this either by clicking in their Close Boxes or by choosing "Close" 
from the File menu. Either method will close the document in the active window. 

2. Pick "Quit" from the File menu. 

You cannot close the original folder by using the "Close" or "Close All Docu­
ments" commands. "Quit" will close any remaining open windows. A dialog box 
will appear, asking whether you really want to quit. Click on "OK" 

Introductory Tutorial: Exploring the IRIS lntermedia Environment 17 



2. ADVANCED TUTORIAL: 
CREATING MATERIALS WITHIN THE IRIS INTERMEDIA ENVIRONMENT 

The step-by-step instructions below will take you through a complete 
session with the IRIS Intermedia system. This tutorial is written for 
users who plan to create original materials and the links that connect 
them. The bold type explains what you are to do or type, and the plain 
type beneath it provides additional details and describes the way the 
computer should respond to your action. In the tutorial, you will be 
working with a number of different IRIS Intermedia applications. 
More complete descriptions of these applications are provided in the 
chapters following this tutorial. 

A. Starting the Tutorial 

18 

A folder called "AdvTutorial" has been provided in your personal 
folder. It contains all the documents that you will need to complete the 
tutorial. All the work that you do in this tutorial takes place in the 
context of the "AdvTutorial" folder. 

Note: The instructions below assume that the materials for the Ad­
vanced Tutorial have been placed in your personal folder which is lo­
cated within a folder called "Users." The setup of your site may not be 
exactly the same. If you have trouble finding the materials for the 
tutorial by following these instructions, consult with your IRIS 
Intermedia System Administrator. 

1. Start up IRIS lntermedla if you have not done so already. 

2. Open the folder called "Users." 

To open a folder, first select the folder icon by clicking on it once and then pick 
"Open" from the File menu. Double-clicking on the "Users" folder icon is another 
way to open the folder. 

3. Locate your personal folder and open it 

Each IRIS Intermedia user has a personal folder in which to store his or her work. 
Your personal folder is titled with your user I.D. which is assigned to you when 
your computer account is created. (You probably logged on to the system using your 
user l.D.) The materials you will need for this tutorial have been placed in your 
personal folder. 
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4. Open the "AdvTutorlal" folder . 

w 
AdvTutorial • lllJ@iiil 

Once you open the "AdvTutorial" folder, you will see the raw materials with 
which you will be working. A window will open on your screen. It contains 
InterWord, InterDraw, and InterVal icons, as well as another folder icon. 

CJ Lr) ~ 
More Docs Authors Science Pope OV Franch Bacon 

Roger Bacon 

B. Creating a Web 

1. Tutorials 

In IRIS Intermedia, documents can be viewed and edited in two ways 
- by themselves, or as parts of webs. In this tutorial, you will be 
creating a web using documents that refer to Roger Bacon. A web 
allows you to create a context in which to organize large amounts of 
related materials. As you will see, it provides a Web View that 
diagrams the links to your active document and records your activities 
during a session. 

1. Pick "New" from the File menu. 

A window containing 
several icons will appear 
in the upper right hand 
corner of your screen. 

iED 

• I c:jl 
folder 

New 

ng 
Val Draw Word 

When you create a new document, IRIS Intermedia places it in the current folder. 
In this case, the "AdvTutorial" folder was the last active folder and is therefore 
considered to be the current folder. 
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2. Double-click on the web icon. 

Selecting the web icon and picking "Open" 
from the File menu produces the same result. A 
wristwatch appears until a Web View window 
opens. It contains an open symbol next to a 
small "Untitled" web icon. As you work 
through this tutorial, the Web View will illus­
trate the links that you make from the active 
document and will keep track of each link you 
follow and each document you open or activate. 

Whenever you activate a different document, 
the Web View will redraw to diagram the links 
to the document you have just activated. 
Scrolling through the Web View is a good way 
to remind yourself of your progress. 

~D§ Untitled 120: Web Uiew § 

0 documents in web 0 links in web IO 

!ill 
~Untitled 120 
Fri May 27 16 :59 :04 1988 

o ' 11rn:mmimmmm:mmrnmrnmmrnmmm:mmm1 c;.; i;:t . 

3. Shrink the Web View window and move it to one corner of the screen. 

You will want to refer to the Web View often, so place it in a convenient location 
and make it large enough to see the original contents. The lower right corner of 
the screen is usually a good location. 

C. Editing an lnterWord Document 

20 

1. Cilek once In the "AdvTutorial" window. 

The window is now activated. 

2. Double-click on the lnterWord document Icon "Roger Bacon." 

Selecting an lnterWord icon and picking "Open" from the File menu will also 
open an InterWord document. A wristwatch appears until the window containing 
the text of the document opens on the screen. 

3. Position your pointer on the Down Scroll Arrow and hold the mouse button down. 

The contents of the document will scroll if there is more text than will 
fit in the window. 
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Correcting Minor Errors 

1. Tutorials 

1. Use the Scroll Arrows to 
search through the document 
for spelling errors. 

The "Roger Bacon" 
document has been 
deliberately altered to 
contain typos and 
spelling errors. 

=o Roger Bacon 
Roger Bacon 

2. Click to one side of a misspelled word, and, holding down the mouse button, drag across the word until it is 
selected. Release the mouse button. 

The selected word is 
now highlighted with 
white letters on a 
black background. 
Double-clicking on 
the word is an alter­
nate way of selecting 
an entire word. 

:o 

3. Retype the word, spelling It correctly. 

Roger Bacon 
Roger Bacon 

Notice that the new typing replaces the letters that were selected. 

4. Locate a group of words that have been run together. 

You will be adding spaces between these words. 

5. Place the pointer between 
two words and click the 
lroJSe button. 

Roger Bacon 
Roger Bacon 

Roger Ba.con (1214?-94) studied a.t Oxfurd a.nd lJi!li 
!IBatPm~. !ll\d. bece.me. $,member of the. Fransican order. !!ii!! A. straight line, called 

an insertion point, 
appears between the 
words. 

6. Press the Space Bar once. 

A space appears be­
tween the words. 

I He. kne.-~ Gre.e.k, Hebrew, a.nd Aramaic, a.nd is re.puted to ha.ve. jliiil!I 
_ ~Y~=~ ~P.e..~8:..cl!-~·- _ ~':: _1..??0 _s~~p_e_~e_?._ c:f _h_~e!r._J::e_ '!~s- _ !illm 

Roger Bacon 
Roger Bacon 

Roger Ba.con (1214?-94) studied a.t Oxfurd a.nd 
nla.tPa.ris, a.nd became a. member of the Fra.nsica.n order. 
He. kne.·~ Gree.k, H e.bre.w, and Aramaic, a.nd is re.puted to ha.ve. 

_ ~y~=~ ~p_e_~a.:J.:~·- _ ~":: _t_?g _s~~P.e_~e_?. _ o.! _h:!_e!r._J::e._ '!~s- _ 
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Reorganizing 

22 

7. Without moving the lnser· 
tlon point, type several 
words. 

Notice that the text 
adjusts to accommo­
date your typing. 

8. Select the words you 
typed (as In step 2) and 
press the Delete key. 

Everything that was 
highlighted disap­
pears and the text 
readjusts itself. 

:o Roger Bt1con 
Roger Bacon 

Roger Bocon 
Roger Bacon 

Roger Bacon (12141-94) studied at Oxford and 
•11•a•m1matParis, e.nd became. a member of the. Fransican order. 
He kne.·~ Greek, Hebrew, and Aramaic, and is reputed to have 

_~~~:cl:. ~~e_t:!_a.?:~·- _ ~~ _1.?~0 _s~~~e_C!_e.E _ o_f _h:!_e~y,_ ~e- !'~~ _ 

9. Practice editing by correcting any other mistakes you find. 

The document contains approximately a dozen errors. 

1. Select an entire sentence 
by dragging over It 

The sentence will be 
highlighted when you 
release the mouse 
button. You can alter 
the order of phrases, 
sentences, paragraphs 
and larger units of 
text by first selecting 
the text and then us­
ing the commands in 
the Edit menu. 

~D Roger Bocon 
of knowledge whichhides ignorance. During his lifetime he.was 
suspetced, because of his scientific experiments, of being a 
wizard in le.ague with the. devil: after his death, he became a 
popular figure in English flakelore, appearing, mo st notably, a.s 
the central character in Robert Greene's corned Friar 13acon. 
and Friar &.ngay. 
di'iiwilliam Ockham, during the next century, continued and 
intensifi~ his attack on traditional scholastici.sm. His emphasis 

~::~ n::~:;:: .:: :~y-:,:~::i. ::"!;· inhoritod by I~ 
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2. Pick "Cut" from the Edit menu. 

The selected text is removed and placed on an invisible Clip­
board. 

3. Position the insertion point somewhere in the text document by moving the 
pointer and clicking the mouse button. 

Find... X/ 

A straight line indicates the new insertion point. 
Look Up XL 

![] Roger Bacon I o s <H"1 lie~ fo rn 
I OSCH1 fl1'1 (ff 

of knowledge. whicbhide.s ignorance.. During his life.time. he.was 
suspe.tce.d, be.ca.use. of his scientific e.xpe.rim.e.nts, of being a. 
wiz a.rd in le.ague. with the. devil: a.fte.r his de.a.th, he. be.came. a. 
popular figure. in English fla.kelore., a.ppe.aring. most notably, a.s 
the. central cha.ra.cte.r in Robt.rt Ore.e.ne.'s comt.dy Friar Ba.con 
a.nd Friar &in.gay. William Ockham, during the. next ce.ntllly, 
continued a.nd intensified his a.tta.ck on traditional s chola.sticism. 
His e.mpha.sis on the. importance. of e.xperime.nta.tion would be. 
illhe.rite.d by Francis Bacon in the. e.a.rly s e.ve.nte.enth ce.ntllly.I 

Du1>li1:<11 <~ :J[:D 

4. Pick "Paste" from the 
Edit menu. 

The text that you cut 
and stored on the 
Clipboard appears at 
the insertion point. 

Select Rll XA 

Hdt1 1: l'<m1 :](:I: 

~ 

.. 0 Roger Bacon 

of knowledge. whicbhide.s ignorance.. During his life.time. he.was 
suspe.tce.d, be.ca.use. of his scie.ntifi.c e.xpe.rime.nts, of being a. 
wiz a.rd in le.ague. with the. devil: a.fte.r his de.a.th, he. be.came. a. 
popular figure. in English fla.kelore., appearing. most notably, a.s 

the. central cha.ra.cte.r in Robt.rt Ore.ene.'s comedy Friar Ba.con. 
a.nd Friar &in.gay. William Ockham, during the. next centllly, 
continued a.nd intensified his a.tta.ck on traditional s chola.stic:ism. 
His e.mpha.sis on the. imp orta.nce. of exp e.rime.nta.tion would be. 
:inherited by Francis Bacon in the. early uvente.enth ce.ntllly. It 
is believed tha.t he. died a.nd wa.s buried a.t Oxford. I ~ 

01 

I 
I 
0 
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Changing Styles 

24 

1. Select "Show Left Palette" from the Arrange menu if the Style List is not visible. 

You can tailor the style of your text document by applying the styles available in 
the Style List that appears in the Left Palette on the left side of the text window. 

If after choosing this command it looks like nothing has happened, try moving the 
whole window to the right. If the document window is rather large, the palette 
might appear off-screen. The Style List will appear in the window's Left Palette. If 
you see "Hide Left Palette" when you pull down the menu, it means the Style List 
(since it is located on the Left Palette ) is already visible. When you are editing or 
formatting a Word document, you will want both the Top and Left Palettes show­
ing. 

2. Select "Show Top Palette" from the Arrange menu If the Ruler Is not visible. 

If the command "Hide Top Palette" is listed instead, it means the palette is al­
ready visible. The Ruler in InterWord is part of the Top Palette. 

Graphics documents also have a Top Palette on the top of the window and a Left 
Palette to the left. You can use the Arrange menu to hide and reveal these palettes 
in the same manner as in text documents. 
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1. Tutorials 

3. Position your Insertion point within one of the paragraphs. 

The Current Style Box, highlighted in black on the Ruler in the illustration below, 
indicates the name of the style applied to the paragraph containing your insertion 
point. Notice that the current style is "Normal." 

~o 
Flush 
Heriding 
Indented Quote 

Numbered Point 
Title 

( New ) ( Rpply ) 

Font: Times 
Romon 12 Point, 

Justified, Indent: 
First 0.25" 

Roger Bacon 

·1 ·~·I I I ,11 ! I I I I I .21 ! I I I I ,31 I I I I I I .41 I I I tl 

Roger Bacon 

I 

Ro ge.r Ba.con (1214? -94) studid a.t 0 xfro d and a.tPa.ris, and ' 

~ 
• I 

be.ca.me. a. munbe.r of e. Fra.ns1can orde.r. He. kne.w Gre.e.'k, 1 

He.brew, and Anm , and is re.pute.d to have. inve.nte.d: 
, I 

spe.cta.cl.e.s. Ca.. 1257, suspe.tte.d ofhe.re.sy, he. was se.nt to Pans ' 
and eonfine.d the.re. for te.n ye.a.rs. Though he.was re.le.as e.d ea.. : 

• I 

1258, he was confined 11.gia.n ca. 1278-92. ' 
I 

He. wrote. La.tin tre.a.tise.s on a. va.rie.ty of tipics--gra.m:ma.:r, ' 
I 

lo fjc, ma.the.ma.tics, fysics, cb.e.mi.stry, and a.lcb.e.my- - and was, • 
I 

for a.11 pra.ctica.l purposes, the. founde.r of English philosophy. he.• 
I 

re.pla.ce.d the. traditional e.mphe.sis on argument from authority• 
I 

with an a.pp e.a.l for e.xp e.rirne.nta.ti.on. He. maintained that the. chie.f • 
I 

ca.us e.s of e:rror we.re. unaiti.ce.l reliance. on custom a.nd authority • 
I 

and the. pretence. of knowledge. whichhide.s ignorance.. During his' 
I 

life.time. he.was susp e.tce.d, be.ca.use. of his s ci.e.ntifi.c e.xp erime.nts, ' 
I 

Advanced Tutorial: Creating Materials Within the IRIS lntermedia Environment 25 



26 

4. Select '1ndented Quote" from the list of styles by clicking on ii and then click on "Apply." 

Flush 

Numbered Point 
Title 

(New}~ 
Normal+ 

Indent: O. Left 
0.75" Right 2.00" 

Roger Bacon 

.?.L. .... ; ....... L. •. l ' 11 I I I I .21 ' I I I I ,31 I I ' I . I ·1 ·•-.l--~ ... L; 

Roger Bacon 

I 

Roger Bacon (12147-94) studied a.t Oxfrod a.nd atParis, a.nd : 
be.came a. member of !the Fra.nsican order. He kne.w Greek, : 
Hebrew, a.nd .Are.ma:.. , and is :reputed to ha.ve invented ' 
spectacles. Ca. 1257, suspected of heresy. he. was se.nt to Paris 
and confined there fo:r ten years. Though hewa.s released ca.. 
1258, he wa.s confined a.gi.a.n ca. 1278-92. 

He wrote La.tin treatises on a variety of tipics--gramma:r, 
logic, ma.the.me.tics, fysics, chemistry, and alchemy-- and was, 
for all practical puxpose.s, the founder of English philosophy. he , 
replaced the traditional emphasis on argument from authority : 
with an a.pp eal for experimentation. He maintained that the chief : 
ca.us es of error were uncritical reliance on custom and authority : 
and the pretence ofknowledge which.hides ignorance. During his : 
lifetime he.was suspetced, be.ca.use of his scientific experiments, ; 

The paragraph that contains the insertion point now reformats and looks like an indented quote. The style in the Current Style Box changes to "Indented Quote." 

-0 
Flush 

Normal 
Numbered Point 
Title 

( New ) ( Rpply) 

Normal+ 
indent: 0. Left 

0.75" Right 2.00" 

Roger Bacon 

.?.L. •.. J... .... L. •. l, 11 I I I I I ,21 I I I I I ,
3

1 I I I I I I ·1·• ... i ...... .i...[ 
~~!i)BJ r=J~§0 (More .. ~ 

Roger Bacon 

Roger Ba.con (12147-94) studied at Oxfrod and 
atParis, and be.came. a me.mbe.r of lthe 
Fransica.n order. He knew Greek, Hebrew, 
and .Aramaic, a.nd is reputed to have invented 
spectacles. Ca. 1257, suspected of heresy, he 
was sent to Paris and confined there for ten 
years. Though he.was released ca. 1258, he 
was confined af9.a.n ca. 1278-92. ~ 

He wrote Latin treatises on a variety of ti.pics--g:rammar, 
logic, ma.thematics, fy'sics, chemistry, and alchemy-- and was, 
for all practical purposes, the founder of English philosophy. he 
replaced the traditional emphasis on argument from authority 
with an appeal for experimentation. He maintained that the chief 
causes of error we.re uncritical reliance on custom and authority , 
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5. Experiment with the available styles. 

You can also create and name your own style by picking "New" from the Style 
List. (See Chapter III. Using lnterWord or Chapter VII. InterWord Reference 
Guide for more information.) 

6. When you are satisfied with the contents, organization and appearance of the text document, pick "Hide 
Top Palette" and "Hide Left Palette" from the Arrange menu. 

The Ruler and Style List will be hidden from view. 

7. Save the changes you have made by picking "Save" from the File menu. 

It's always a good idea to save your work periodically to protect yourself from 
system errors. 

D. Creating a Link 

1. Tutorials 

1. Select the words "Roger 
Bacon" in the first line. 

These words will be 
turned into an anchor 
point or block for a 
link after you com­
plete the next step. 

-0 Roger Bacon 

Roger Bacon 

l@iil@ii(t214?-94) stlldie.d at Oxfrod a.nd a.tParis, 
and be.came. a. member of the. Fra.n~ca.n order. He knew Gre.e.k, 
H e.bre.w, and Aramaic, and is re.pute.d to have. inve.nte.d 
spectacles. Ca.. 1257, suspected ofhe.resy, he. wa.s se.nt to Paris 
and confined the.re for te.n ye.a.rs. Though hewa.s released ca.. 
1258, he. wa.s confined a.gj.an ca.. 1278-92. 

He. wrote. La.tin treatises on a. variety of tipics--g:ramma.r, 
logj.c, ma.the.ma.tics, fysics, chemistry, and alchemy-- and wa.s, 
~or all practical puzpose.s, the. founder of English philosophy. he. 
ire.placed the traditional e.m.pha.sis on a.rgume.nt from authority 
with a.n a.ppe.al for e.xpe.rime.nta.tion. He. ma.inta.ine.d that the. chief 
ca.us e.s of error we.re uncritical reliance on custom a.nd authority fO. 
Q l!!!!!~i!l!!! l!!i~!li!l!i!l!J!l!lil!lli!!l!ll!i!l!i!!l!lll!!!!ii!!!i!!!!l!!i!!lli!!!!lll!!Jlil!lifH!!lliillliI!i~lll~l!!!!!J!!!!!i!llil!!i!J!!illl 0 f2J 
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2. Pull down the lntennedia menu and pick "Start Link." 

A wristwatch may appear briefly. 

3. Activate the "AdvTutorial" folder window by clicking once 
anywhere in the window. 

You may have to move the open InterWord window 
to find the folder behind it. 

4. Open the Interval document called "Authors." 

Either double-click on the icon or select it and pick 
"Open" from the File menu. 

5. Click on the text "Roger Bacon" in the timeline. 

I: om1>h~h~ I.ink 
Unlink 

Create Block 
IJnhlock 
Stlow E!lo(k l'.Ht<rn1 

User Properties ... 
Document Properties ... 
HI o ck P l'OJl<ff1i<~~, .. 
I.ink Prop(ff1ic~~---
Uiew Specs ••• 

i: ollow 

Authors 

Selected 
British Authors It should be highlighted - surrounded with 

black squares called handles. This time­
line event will serve as the destination of 
the link. 

1214 toger)a~on § 

6. Pick "Complete Unk" from the lntennedia menu. 

A link is now established between the text 
"Roger Bacon" in the InterWord document 
and the Roger Bacon event on the timeline. 
Link markers are placed above both the 
source and destination selections. 

Note: In some IRIS Intermedia 
installations, a dialog box containing a 
Link Property Sheet will appear after you 
pick "Complete Link." If this happens, refer 
to Subsection I. Setting Viewing 
Specifications of Chapter II. Using IRIS 
Intermedia. 

1561 Francis Bacon 

1564 William Shakespeare 

1688 Alexander Pope 

Samuel Johnson 

7. Try following your link by double-clicking on the marker in the lnterVal document 

The "Roger Bacon" text window should pop into view and the words you selected as 
the block extent should be outlined v1ith a marquee. 
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8. Follow the link In the other direction. 

The timeline will pop up. 

s File Edit lntermedia Font Arrange Print 

Roger Bacon 
Roger Bacon 

BRoger Bacon (12147-94) studied at Oxfro 
became a member of the Fransicart order. 
Hebrew, and P..ramaic, and is reputed t 
spectacles. Ca. 1257, suspected of heresy, he 
and confined there for ten years. Though h 
1258, he was confined a.gian ca. 1278-92. 

He wrote Latin treatises on a variety o 
logic, mathematics, 1i1sics, chemistry, artd al 
for all practical purposes, the founder of Engh 
replaced the traditional emphasis on argum 
with an appeal for experimwtation. He maint 
causes of error were uncritical reliance on c11s 

Authors 

Selected 
British Authors 

= 
12 14 ~oger ,a~on 3 
1561 Francis Bacon 

1564 William Shakespeare 

1688 Alexander Pope 

9. Close and save the "Authors" document by clicking in the Close Box. 

Click "Yes" in the dialog box when you are asked "Save changes before closing?" 

E. Startina Another Link ... 

1. Tutorials 

1. Select the word "Spectacles" in the second sentence of the "Roger Bacon" lnterWord document 

You will be making that word into a block by starting a link. You will not com­
plete this link immediately. 

2. Pull down the lntermedia menu and pick "Start Link." 

A wristwatch may appear briefly. Until you complete the link you have started 
here, the InterWord document will not reflect the existence of a block. As a conve­
nience, IRIS Intermedia allows you to perform any number of actions before you 
complete a pending link. In this case, you will open an lnterVal document, add an 
event to it and then complete the link. 
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F. Manipulating an Interval Document 

30 

1. Click in 1he "AdvTutorial" window. 

The window is now activated. 

2. Double-dick on the lnterVal Icon called ''Science." 

A wristwatch appears until the timeline appears on the screen. The timeline 
named "Science and Technology" chronicles important inventions and scientific 
discoveries between 1700 and 1905. 

3. Pick "Add Event" from the Edit menu. 

A dialog box appears on your screen. 

4. Type "1260" In the first 
field of the dialog box. Rdd an euent flt what year? .... I 1_2_6_0 ___ ___, 

The year 1260 appears 
at the insertion point . 

label? Roger 88con inuents spectllcles. 

.. ( Cancel 

5. Press the Tab key to move to the next field in the dialog box. 

Now the insertion point moves to the first line of the "Label?" box. 
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6. Type "Roger Bacon Invents specta· 
cles," and pick "OK." 

The dialog box disappears 
while the timeline is enlarged 
and the new event is added to 
the timeline. The event is sur­
rounded with handles. 

1260 

1733 

1758 

1764 

1769 

1774 

Science 

Science and 
Technology ,,,,., 

= l!!ii! 
~oger Bacon inv:nts spectacles.! i\lili 

John Kay•s flying ~ !j!J!j 

First threshing 
machine. 

James Hargreaves 
invents the spinning 
jenny. 

Arkwright's spinning 
machine. 

Priestly Isolates 
oxygen. 

G. Completing the Second Link 

1. Tutorials 

Remember that the link you began in the text document in Subsection 
E. has still not been completed. Since you have a timeline open on your 
screen, you can establish one of its events as the destination of the 
pending link. 

1. Choose "Complete Link" from the lntennedla menu. 

Be sure the text "Roger Bacon invents spectacles" is still selected (surrounded by 
handles). If it isn't, click once on it and pick the "Complete Link" command. 
Wnen the wristwatch vanishes, notice that a marker appears above the selected 
event. 

2. Follow your link by doublKlicking on the marker. 

The "Roger Bacon" document should pop up and the word "spectacles" should be 
outlined with a marquee. 
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3. Click In the Web View window. ~O~ Untitledl 20: Web Uiew ~ 

You may have to move some overlapping win­
dows out of the way. The Web View now shows 
the first two connections in your web. A line 
connects the current document, "Roger Bacon," 
to the "Authors" InterVal icon and to the 
"Science" InterVal icon. If the marker associ­
ated with spectacles is still selected when you 
activate the Web View, the line leading to the 
"Science " icon should be bold. This tells you 
that the other end of that link is in the 
"Science" InterVal document. 

3 documents in web 2 links in web 

~ 

~Science 
Fri May 27 18 :33 :16 1988 

iii Roger Bacon (Block 4 ) 
Fri May 27 18 :35 :45 1988 

~Authors ~Science 
~ 

4. Re-activate the "Science ''window by double-clicking on its icon in the Web View. 

Iii:!\ 

11111 

If a document is buried under several other windows, you can always reactivate it 
by selecting it from the Web View. Double-clicking on an icon in the Web View 
achieves the same effect as double-clicking on an icon in a folder window. This is 
another good reason to keep the Web View window in a convenient location. 

H. Setting Block Properties 

32 

Block Property Sheets are used to specify information about particular 
blocks. Though IRIS Intermedia automatically assigns each block a 
number, these property sheets give you the opportunity to provide other 
users with more descriptive information. In a complex web, with 
many overlapping and criss-crossing links, "verbose" descriptions of 
blocks can help a user navigate from one document to another with a 
better sense of direction. 

1. FOllOIN the link you have just made by selecting the marker and picking "FollOIN" from the lntermedia menu. 

The text document in which you started the link appears on the screen. Notice that 
the link marker is highlighted and positioned above the first character of the block 
(the word "Spectacles") and the word is outlined. 

Advanced Tutorial: Creating Materials Within the IRIS lntermedia Environment 1. Tutorials 



1. Tutorials 

2. Pick "Block Properties ... " from the lntermedla menu. 

Be sure the marker is 
still selected when you 
choose this command. A 
dialog box appears with 
the following informa­
tion filled in: 

BLOCK PROPERTIES 

Blocks 

Bloik 5 r!'} 

[ 
EHpl11lner 

CrHtlon D11te: Fri J11n 13 09:57:49 1989 

Ruthor: ny 

K Apply & Close J ( Rpply ) ( C11ncel 

3. Replace the words "Block 5" from the explainer field by typing "Spectacles," and pick "Apply & Close." 

Now the block can be identified. The dialog box will disappear after you pick 
"Apply & Close." 

4. Follow the link again, back to the ''Science" tlmellne. 

You should also name the block which serves as the other endpoint of the link. 

5. Pick "Block Properties ... " once more. 

The dialog box will again appear. 

6. Name this other block "Spectacles invented," and choose "Apply & Close." 

Name the second block as you did the first in step 2. Now both blocks of the link 
are named. 

Advanced Tutorial: Creating Materials Within the IRIS lntermedia Environment 33 



I. Setting Viewing Specifications 

When you are working on a web, it may become inconvenient to pick 
"Block Properties ... " each time you create a link. IRIS Intermedia allows you to specify some of the conditions under which you make 
links. By changing the settings in the "Viewing Specifications" dialog, you can have Link Property Sheets appear automatically as you start 
and complete links. A Link Property Sheet allows you to enter an explainer for both the source and destination blocks of the link. 

1. Pull down the lntennedia menu and pick ''View Specs ... " 

The Viewing Specifi­
cations dialog box 
appears. 

UIEWING SPECIFICATIONS 

Note: It is possible 
that "Link Creation" 
is already set to 
"Verbose." If so, skip 
step 2. 

Block Creation: 

Link Creation: 

~ OK 

0 Verbose 

~Verbose 

1 ( Cancel 

®Fast 

®Fast 

) 

2. Click on the radio button next to ''Verbose" in the category of Link Creation and click "OK." 

The dialog box disappears. Now whenever you create a link, IRIS Intermedia will prompt you with a dialog box requesting "explainers" for the blocks at either end of the link. An explainer is a short descriptive name for the block. As you use the system more and more, you will discover how useful it is to enter explainers -they really do aid you in exploring a web, especially when the web contains nu­merous documents and blocks. 

J. Opening a New lnterDraw Document 

34 

1. Without closing the lnterv al documen~ pick "New" from the File menu. 

The "New" window will pop to the top of the screen if it is obscured or open if it was closed. 
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1. Tutorials 

2. Double-click on the Draw Icon. ro New 

Selecting the icon and 

@ lid • picking "Open" from the 

I 

~ File menu has the same 
effect. A wristwatch ap- Web folder Val -pears until the new In-
terDraw window begins 
to take shape on the 
screen. 

Notice that the window opens with a Style Palette and a Tool Palette 
ready for use. In order to draw Roger Bacon's spectacles, you will need 
to use several different tools and styles. The arrow tool is selected au­
tomatically. 

3. Select the Oval tool by clicking on the oval in the Tool Palette. 

Now the oval, rather than the arrow, is highlighted. 

4. Position the pointer In the drawing area. 

You can now draw any number of ovals. 

5. With the mouse button de­
pressed, drag the oval out to a 
suitable size and release the 
button. 

Current 
Settings 

Untitled 

Fill TeHt Background Line 

You are drawing one of 
the lenses of Bacon's 
glasses. 

6. Now try to make another oval 
the same size next to the first 
ava 

While the Oval tool is 
selected, you can make 
any number of ovals in 
a row. Notice the diffi­
culty of making two 
identical ovals. 

Ruailoble 
Patterns 
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7. Click on the Arrow tool. 

The Arrow tool high­
lights in the palette. 
With the Arrow tool you 
can select objects you 
have created. 

8. Draw a "bounding box" 
around the unsatisfactory oval 
or ovals. 

You have selected the 
oval(s). Small black 
handles surround each 
oval entirely encom­
passed by your bound­
ing box. 

9. Pick "Clear" from the Edit menu. 

~D-

Current 
Settings 

Auailable 
Patterns 

~D 

Current 
Settings 

Auailable 
Patterns 

The selected ovals will disappear. 

Untitled 

Fill TeHt Background line 

Untitled 

[El ~ • Fill TeHt Background Line 

10. Click on the remaining oval to select it and pick "Copy" from the Edit menu. 

I 

Line: 
I 

v-: 
I 

-..i 
I 
I -I .. 

I 

Line: 
I 

v-: 
I ..... 
I 
I -I • 

Be sure that you put the arrow directly on top of the line making up the oval. Han­
dles appear when the oval is selected. You can now paste an exact copy of the oval 
next to its original. 
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1. Tutorials 

11. Click in the spot where you want the upper left of the copy to be positioned and pick "Paste" from the 
Edit menu. 

Now you have two identical "lenses." Don't worry if they aren't aligned properly. 

12. Hold down the Shift key and select the original oval by clicking on il 

Now both ovals are selected. The Shift key is often used to extend selections. 

13. Pick "Align Bottoms" from the Arrange menu. 

Now the ovals are parallel to one another. 

14. Click on the Line tool in the Tool Palette at the left of the window. 

The Line tool is the third one from the top. 

15. In the Style Palette, click on 
the second line under "Line 
Widths." 

The checkmark moves to 
reflect your choice. 

16. Connect the two ovals with a line. 

ID 
current 
Settings 

Au11ll11ble 
Pattern• 

~o Untitled 

Current [!] CE] • Settings 

Fill TeHt Background Line 

Ruailable 
Patterns 

Untltled 

Line: 
I 
I ___, 
I 

v'-' I 
I -I 
I -I 

• Line Widths Arrowheads 

Advanced Tutorial: Creating Materials Within the IRIS lntermedia Environment 37 



38 

17. Click on the "t" tool in the Tool Palette. 

Now you can add text to your diagram. Only a scholar would be able to identify the 
artifact; students will need a label to recognize Bacon's invention. 

18. Click on the mouse button to set an insertion point 

Your text will begin at the insertion point. 

19. Type "Bacon's Spectacles." 

Now your drawing is complete. 

~D Untitled 
I 

Current 0 ~ • Line: 
Settings I 

I 

TeHt Background Line 
--1 

Fill I 

v-' Ruailoble I 
I 

Patterns -I 

I -I 

Bacon-'s Spectacle!~ 

20. Experiment with the other styles available in the Style Palette. 

Try making the spectacles into sunglasses. (Hint: select an oval and pick an 
Available Pattern.) Be sure you first select the Arrow tool. 

21. Experiment with the other tools available in the Tool Palette. 

Notice that the same tool, the Line tool, can be used to create both lines and arrows, 
depending on its style. 
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22. Experiment with "Undo" from the Edit menu. 

IRIS Intermedia puts no limit on the number of "Undo" commands you can select 
in a row. Each "Undo" command that you issue undoes the last action that you 
performed. If you drew a line, it takes that line away. If you cut an object, it 
replaces that object. 

23. Experiment with "Redo" from the Edit menu 

"Redo" undoes the last "Undo." 

K. Saving and Naming a New Document 

1. Save your work by picking "Save" from 
the Rle menu. 

A dialog box appears: 

2. Type "Glasses" to name your new 
drawing. Click on the ''Save" button. 

Now the drawing is saved and 
named. It will be stored in the 
"AdvTutorial" folder, which 
was the last activated folder. 

Saue this document as: 

Saue Cancel ) 

Saue this document as: 

I Glasses 

Cone el 

New documents are always stored in the most recently activated folder. 

L Creating a Link with Block Explainers 

1. Tutorials 

1. Select one of the lenses In your drawing by clicking on it 

Be sure the Arrow tool is active. Handles will appear around the lens when it is 
selected. 

2. Pull down the lntermedia menu and pick ''Start Link." 

When you start a new link, you also create a new block. 
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M. Completing a Link using an Existing Link Marker 

40 

1. Cilek once In the lnterVal window called ''Science." 

Black stripes appear in the Title Bar, indicating that the "Science" timeline is the 
active window. 

If the "Science" window is covered up, you can double-click on the lnterVal icon 
named "Science" in the Advanced Tutorial folder window or in the Web View 
window, or you can move the windows that are in the way by dragging them to 
new locations. 

2. If the link marker in the "Science" timeline Is not already selected, click on It once. 

The link marker will be highlighted. 

3. Pick ''Complete Unk" from the lntennedla menu. 

A Link Property Sheet appears. Since you set "Link Creation" to verbose in 
Subsection H, IRIS Intermedia gives you a property sheet for the link, which 
allows you to assign block explainers to the blocks at the endpoints of the link. 

4. Enter ''lens" as the source block explainer. 

In this case, the source block is the eye glass lens. When you type the word "lens," 
your typing will replace the system-assigned block name which is automatically 
selected when the dialog box appears. Notice that the destination block already has 
the explainer "Spectacles Invented." This is the block you named in step 6. of Sub­
section H. If you had selected a graphics object, a timeline event or some text in­
stead of an existing link marker, you would have had to enter an explainer for the 
destination block as well as the source block. 

5. Click "OK" In the Unk Properties dialog box. 

The dialog box closes and a wristwatch icon appears while the link is being 
created. You should see new connections reflected in the Web View, with lines 
indicating links connecting the lnterDraw icon, "Glasses," to the InterVal icon, 
"Science," and the InterVal icon to the InterWord icon, "Roger Bacon." 
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6. Double-click on the marker to follow the new link. 

A dialog box asks you to choose which link to follow. On the left side of the dialog 
box is the name you gave to the block associated with the "Roger Bacon" event. On 
the right side are the names of the documents at the other ends of the links. These 
are followed, in parentheses, by the block names you assigned. 

Please choose a source and then the destination 

Source Destination 

Spectacles Int• e ... ~ Glasses llensl ~ 
Roger Bacon (Spectacles) 

( Cancel J 

7. Pick the document/block pair "Glasses (lens)" from the list of destinations and click on "OK." 

In a complex web, with many overlapping and criss-crossing links, "verbose" 
descriptions of blocks can help a user navigate with a better sense of direction. 

Notice that a link marker has appeared above the lens you selected as the source 
point of the link. 

You should now see only one connection in the Web View, with a line indicating a 
link connecting the InterDraw icon, "Glasses," to the InterVal icon, "Science." 
The other links still exist within the context of the web, but the connections are no 
longer visible in the Web View because they do not involve the active document 
("Glasses"). 

N. Saving Links 

1. Tutorials 

1. Cilek In the Web View window to activate it. 

Its Title Bar should be striped. 

2. Pick ''Save" from the File menu and click on "OK" in the dialog box that appears. 

This dialog informs you that the documents containing the links will be saved 
before the web itself is saved. Note that all of the links created within the context of 
the web will be saved, including those that do not appear in the Web View at the 
present time. After all the documents containing new blocks and links have been 
saved, a dialog box appears, asking you to name the new web. 
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3. Type "Bacon Web," and click on "Save." 

The system takes its time performing this vital action. When the wristwatch dis­
appears, the web has a name and the links are saved. An icon representing the 
web also appears in the "AdvTutorial" folder. It is a good idea to save the web at 
regular intervals to protect yourself from losing work in the case of a system 
failure. 

0. Making More Links 

1. Experiment with making more links. 

Extra materials, in the form of diagrams, text documents and timelines, have 
been placed in the "AdvTutorial" folder. These materials were created by 
Professor George Landow for a survey course on English literature taught at 
Brown University. All the documents are related to each other in some way. You 
can experiment with these materials and you can create new documents as well. 

2. Open the folder called ''More Docs." 

You will find more document icons in this folder. In each InterWord document, 
words or phrases have been made bold to indicate that they might make appropri­ate anchor points for links. Try making a link between a document in this folder 
and one in the "AdvTutorial" folder. You can also make links between 
documents that reside in different folders. 

P. Closing a Web 

42 

When you have experimented enough and feel you will return to IRIS 
Intermedia with a better sense of its features, you will want to close the 
web you have made. 

1. Ciiek In the Close Box of any open document 

Position Click 

If you wish to save your changes, respond accordingly in the dialog box. You can 
also pick "Close All Documents" from the File menu if you have many documents 
open. This command closes all open documents, including the Web View, but it 
does not close folder windows. If you pick "Close All Documents," skip to step 3. 

Advanced Tutorial: Creating Materials Within the IRIS lntermedia Environment 1. Tutorials 



2. Click in the Close Box of the Web View. 

If you have made links that have not yet been saved, you should say "OK" to the 
questions in the dialog boxes. 

3. H you have never saved this web before, you will also have to give it a name. (See Subsection K.} 

Once the web is saved and named, it closes. 

Q. Exiting the System 

1. Tutorials 

When you have completed all your work, saved and closed all new doc­
uments, and saved and closed your web, you must exit the system so 
others can use it after you. 

1. Pick "Qulf' from the Ale menu. 

After you have quit IRIS Interrnedia, you should log off the system. 
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II. USING IRIS INTERMEDIA 

This section describes how to perform the essential IRIS Intermedia 
operations. If you have stepped through the tutorials, you should 
already be familiar with many of the operations described below. In the 
following explanations, the bold type explains what you are to do or type 
and the plain type underneath describes the step in greater detail. The 
explanations assume that you are already familiar with the operation of 
the mouse and menus. If you are not, refer back to Chapter I. 
Tutorials. 
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1. OVERVIEW OF THE IRIS INTERMEDIA DESKTOP 

The IRIS Intermedia desktop is made up of a variety of objects which 
allow you to interact with the system. The most important of these are 
documents which are created using any of the applications provided in 
the IRIS Intermedia system. They are organized on the desktop in 
folders, which are analogous to paper folders in an office. Since folders 
can contain subordinate folders in addition to documents, you can 
create a hierarchical organization of your materials. 

Webs provide an alternate, but complementary, mechanism for orga­
nizing documents. While any one document may only be stored in a 
single folder, that same document can be referenced in any number of 
webs, which can be thought of as contexts. For example, a biography of 
Charles Darwin might be stored in a "History of Science" folder, but 
referenced in webs called "Scientific Thought," "Evolution" and 
"British Literature." Instead of imposing a hierarchical structure, 
webs allow you to organize materials non-hierarchically. By creating 
anchor points in documents, called blocks, and linking them to anchor 
points in other documents, you are able to create a network of related 
materials. Documents, blocks, and links all have properties associated 
with them, such as the name of the person who created them, the date 
and time they were created, and the date and time they were modified. 
This information is stored in property sheets. 

Documents, folders and webs are all represented on the IRIS 
Intermedia desktop using icons and are viewed in windows. Icons 
indicate the existence of documents, folders and webs while windows 
allow you to view their contents. You are able to interact with desktop 
objects using a rich set of commands. These commands are issued by 
using menus, palettes or the keyboard. 

The explanations below detail the manner in which desktop objects 
can be manipulated. 

2. Using IRIS lntermedia Overview of the IRIS lntermedia Desktop 49 



2. WINDOWS 

Windows are views into portions of documents, folders and webs. Upon 
starting an IRIS Intermedia session, a folder window is automatically 
opened for you. 

A. Opening Windows 

1. Position the pointer (arrow cursor) over a documen~ folder or web Icon and click the mouse button. 

The icon is now selected (highlighted in black). 

2. Choose the "Open" conmancl from the Fiie menu. 

A window containing the selected document, folder or web will open on the screen. 
An alternate method of opening a window is to position the pointer over a docu­
ment, folder or web icon and double-click the mouse button. 

B. Moving Windows 
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1. Position the pointer over the TIUe Bar of any open window. 

Be sure not to position the pointer over the window's Close Box. 

2. Press and hold down the mouse button. 

The window border will become "fuzzy." If you are not sure where the Title Bar is, 
refer to the Folder Window Diagram in Subsection C. Repositioning and Manipu­
lating Windows of the Introductory Tutorial in Chapter I. 
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Hint... 

3. Keeping the mouse button depressed, drag the window. 

/ClassDocs/Dickens 

5 items rt1 

The border of the window will follow your movements. 

4. Release the mouse button when the window's outline is in the desired location. 

When you lift up on the button, the window will move to the new location. 

5. Stack your windows In a fan formation for easy access. 

5 

D 

/ClassDocs/Dickens 

Dickens and Religion 
Dickens and Reform 

Dickens and Social Reform: 

Dickens lived in a time of enormous mm 

political and social changes. His age was also 
an age of social reform: the Reform Act of 
1832, which extended the right to vote, was 
passed a year before the publication of 
Sketches by Boz, his first work of any 
importance, and ~he Reform Act of 1867 went 
into effect less than two years aft.er the 
publication of Our Mutual Friend, his last 

If you have a number of windows open on the screen at once, it is useful to stack 

them in such a way that windows won't get lost or buried. The fan formation, 
shown here, is one way to do this. 
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C. Resizing Windows 
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1. Position the pointer over the Resize 
Box of the active window. 

The Resize Box is located in 
the lower right corner of the 
window. 

Word £Hample 

Sample lnterWord Document Q 

Thi d d . I W d mm s o cume.nt was c:re.e.te. using nte.r or , i!i!!i 

Intenn.e.dia' s word pro ce.s sing pro gram. As you ste.p l!iiii 
through this tutorial, you will notice. that the. sample. mm 
material re.fe.rs to the. history of the. Institute. for Res e.e.rch K} 

Q I liii!ii!iiiiii!!H!iiiiii!iiiii!iiii!ii!iiiiii!iii!!iiii!iiiii!i!!iiii!i!iiliiiiliiii!iiiii!ii!i!ii!iii!iiiWi!ii!i!!i!iii!ii!il Q i;1: 

2. Press and hold down the mouse button and move the mouse. 

An outline of the lower right 
corner of the window will 
follow your movements. 
Some windows have a 
minumum size, often when 
the Top or Left Palettes are 
visible. If this is the case, the 
outline will stop following 
your movements when the 
minimum size is reached. 

3. Release the mouse button. 

r~ci' ............................................. iu·c;·r·Ci··'E·~·~·ili·J;·i·0 ..................................... . r ....................... sampfe .... 'i'nie·rw·<>r:ci ... i5o.c'lime.nt .... _ ...... ! 

This document was created using Int~W?rd, mm 
Interrnedia's word processing program. As yoif Sl:ep mm 
through this tutorial, you will notice that the ~ arc\ple mm 
material refers to the history of the Institute. for Re~ e~ch ..... 

~ 

The window should now have assumed a new size, either larger or smaller, de­
pending on the position of the window's outline when you released the button. 
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D. Scrolling 

In many cases, only a portion of a document, folder or web can be 
viewed in a window at a time. A technique called scrolling is used to 
move contents of the window in and out of view. There are two tools 
provided for scrolling windows: Scroll Arrows and Scroll Boxes (see 
window diagram in the Introductory Tutorial, Subsection C. Reposi­
tioning and Manipulating Windows). The arrows are used for 
scrolling a little bit at a time and the Scroll Boxes are used for scrolling 
screenfuls of information or for moving quickly to a different part of a 
document. 

Using the Scroll Arrows 

1. Position the pointer over one of the Scroll Arrows. 

Each window has four Scroll Arrows: up and down arrows on the right side of the 
window, and right and left arrows on the bottom of the window. The Scroll Arrows 
will only work if the Shaft in which they are located is gray. 

2. Click the mouse button. 

A single click on the Up Arrow will allow you to see information above the current 
information by scrolling the contents of the window down one line. The Down Ar­
row has the opposite effect. Likewise, a single click on the Right Arrow scrolls in­
formation to the right of the current position into view and the left arrow does the 
opposite. 

3. Hold the mouse button down for several seconds while it Is positioned over a Scroll AITTIN. 

The contents of the document will move in and out of view continuously as long as 
the mouse button is depressed. Notice that the Scroll Box moves in the Shaft to re­
flect your current position in the document as you use the Scroll Arrows. For ex­
ample, if the Scroll Box is near the bottom of the right Shaft, this indicates that you 
are near the end of the contents of the window. 

Using the Scroll Box 

1. Position the pointer over the Scroll Box in the right Shaft. 

The Scroll Box located in the 
Shaft allows you to move to a 
new position in the window. 

If the Shaft of the window is 
white and not gray, this in­
dicates that the entire con­
tents of the window is al­
ready in view. The Scroll 
Box will not be visible. 
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=o Word EHample 
Sample lnterWord Document :Q 

~::i::~l~:~·i!:~~?!.::~~~~~11;)0:1 .. _ .. l_,.1,;_ .. 1_ .. 1 .. _.• 
mate.rial re.fe:cs to the history of the Institute. for Research. 
in Information and Scholarship (IRIS) or to Ore.ham 
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2. With the mouse button depressed, ~~D~~~~~~W~o~rd~EH~a~m~pl~e~~~~~~~ 
drag the Scroll Box towards the bot· Sample lnte!Word Document Q 
tom of the Shaft. 

An outline of the Scroll Box 
will follow your movements. 

3. Release the mouse button at any 
point in the Shaft. 

The Scroll Box will move to 
the new position in the 
Shaft and the window will 
scroll so that you are view­
ing the contents farther 
along in the document. 

Int!:dia~:~: p~::s,::e.~er:gr:~~sln;:ws~r~ I 
through this tutorial, you will notice the.t the sample ~ 
mate.rial re.fus to the history of the Institute for Research. I 
in Infonn.ation and Scholuship (IRIS) or to Graham 0 

O I l!i!i!i!iii!ii!!i!!ii!ii!iii!iliiiiiiiil!!ii!iii!lii!il!i!!ii!!i\liii!ii\!!ii!!irniiii!!liiiiiiiiiiiiiiii\ilii!ii!!iili!i!i!i!ii!i!I r,; l2J 

Using the Scroll Shaft 
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1. Position the pointer in the Shaft above or below the Scroll Box. 

Be sure the pointer is in the Shaft above the Scroll Box (as shown in the illustration 
in step 3. above) or below the Scroll Box. 

2. Ciiek the mouse button once. 

The contents of your window will now scroll up or down one screenful. Clicking 
in the Shaft above or below the Scroll Box allows you to scroll the contents of the 
window up or down by screenfuls. Likewise, clicking in the bottom Shaft to the 
right or left of the Scroll Box allows you to scroll the contents of the window right 
or left by screenfuls. 
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E. Showing and Hiding Palettes 

Most IRIS Intermedia document windows have one or more tool 
palettes that can optionally be shown or hidden. Usually you will want 
to have the palettes shown when you are editing a document and 
hidden when you are just browsing or reading. Palettes are identified 
in the Arrange menu by their position with respect to the window. 
Some applications just provide a Left Palette while others provide a 
Top Palette as well. For example, the InterWord Ruler is provided in 
the Top Palette of all InterWord windows and the list of styles is 
provided in the window's Left Palette. 

1. Open or activate a document window. 

Only InterWord, lnterDraw and InterVal windows have palettes associated with 
them. 

2. Pull down the Arrange menu and choose "Show Left Palette" or "Hide Left Palette." 

Only one of these two commands will be available depending on whether or not the 
Left Palette of the active document window is currently shown or hidden. You 
should see the effects of the command immediately. If the Left Palette was hidden, 
it will now be displayed. If it was displayed, it will now be hidden. 

Some documents also have a Top Palette with additional tools. You can use the 
Arrange menu to hide and reveal Top Palettes in the same manner as Left 
Palettes. If a document window has two palettes available, you must show and hide 
them one at a time. 

3. Pull down the Arrange menu again. 

If you displayed the Left or Top Palette in step 2., you will now notice that the 
command you chose has changed to "Hide Left Palette" or "Hide Top Palette" to 
reflect the new state of the window. 
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F. Closing Windows and Quitting IRIS lntennedia 

To avoid cluttering up the screen, you may wish to close windows after 
you have examined their contents. 

Closing One Window at a Time 

1. Close the current window by dicking once in the Close Box. 

Position the pointer over the white box in the upper left corner of the window and 
click the mouse button once. 

Position Click 

The window closes, returning to its iconic representation. If you have made any 
changes to the contents of the document in the window, you will be prompted to 
save changes before the window is closed. 

Closing All Documents 

1. Choose "Close All Documents" from the File menu. 

All document windows and the Web View will close. This is a quick way to un­
clutter the screen. Folder windows will not be affected by this command. You will 
be prompted to save changes to any documents or webs that have been altered and 
not previously saved. 

Exiting the System 
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1. Choose "Quit" from the Ale menu. 

The "Quit" command closes all open windows, including folder windows, and 
ends the current IRIS Intermedia session. 

2. Ciiek on "OK" or "cancel" In the Quit dialog. 

The dialog box asks you to confirm that you would like to end the current session. 
If you choose "Cancel," the IRIS Intermedia session will not end. If you choose 
"OK," you will be prompted to save changes to any documents that were altered but 
not saved in the current session. 
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3. FOLDERS 

Folders are containers for documents, webs and other folders. They al­
low you to organize material hierarchically. When you first start the 
IRIS Intermedia system, there is always one folder open on the 
desktop. This folder cannot be closed until you quit the current session. 

Icons are organized alphabetically by type in IRIS Intermedia folders. 
When you browse through the folder hierarchy, you will notice that all 
webs are arranged alphabetically followed by all folders, followed by all 
InterVal documents, etc. As new documents, webs and folders are 
created, they are automatically stored in the last folder which you acti­
vated. Each new icon will initially appear after the last icon in the 
folder; however, once you close and reopen the folder, the new icon will 
be displayed in its proper position alphabetically. If you wish to change 
the location of one or more documents, webs or folders, you may do so 
by moving their icons from one folder to another. 

A. Creating New Folders 

After you have created a number of documents, you may wish to orga­
nize them more efficiently by placing them in folders. 

1. Pick "New" from the File menu. 

A window will appear containing icons, including one called "Folder." 

2. Click on the Folder Icon New 

It will be selected. 

Web & Vel 

3. Pick "Open" from the File menu. 

A dialog box will appear, allowing you to name the new folder. You may double­
click on the folder icon in the "New" window instead of steps 2. and 3. 
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4. Type In a name for the new folder. 

The name you typed will ap­
pear where the dialog previ­
ously indicated "Untitled." 

5. Click on the "OK" button In the dialog 
box. 

Your newly created folder will 
appear as the last icon in your 
current folder window. 

Ple8se n8me the new folder: 

K OK ] ( Cancel J 

Please name the new folder. 

I Dickens 

(( OK lt )J ( Cancel ) 

8. Moving Icons 

All icons representing documents, webs and folders can be moved to 
new locations within their current folder or to locations in different 
folders. Moving icons is useful for keeping your work organized and 
for storing material in an order that is easy for you to remember. 

Note: If you change the location of an icon in its current folder, the 
change is not saved once the folder is closed. 

Moving One Icon at a Time 
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1. Position the pointer over an Icon. 

All icons are moved in the same manner. You may want to move icons around to 
organize them within their current folder (although this change is not saved) or to 
move them to a different folder. Documents, webs or folders that are open cannot 
be moved. If any of these items are open, their icons will be grayed in the folder 
window. 
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2. Press the mouse button and drag the Icon. 

While the mouse button is depressed, an outline of the icon will follow the move­
ments of the mouse. 

Dicken3_Humor Dickens_Populer 

Dickens-Reform Dickens-Religion 

• DickeM_Humor 

• 
Dickens_Populer 

~ 
~ 

Dickens-Reform Dickens-Religion 

DickeM_Humor Dickens_Populer 

~ 
~ 

Dickens-Reform Dickens_Religion 
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3a. Release the mouse button when 1he Icon's outline Is In the desired lacallon. 

Icons may only be moved within the same folder window or into a different folder 
window. They may not be moved into document windows, the Web View window, 
the "New" window, or onto the gray portion of the desktop. 

To move an icon to a different folder: 

60 

3b. Release the mouse button when the Icon's outline ls over the desired falder Icon. 

The folder will tum black when the icon's outline is directly over it. When you 
release the mouse button, the document will have moved into that folder. 

- - ___ -

-- ---=-=- -----==--

r!ii1 ~ ~ !Pl 
lLi ~ ~ LtJ 

AubrelJ Beerdsl BeerdslelJ Overvie'W Dec:edence Overvie'W Dic:kensTL 

ii ~.±21 rNon~ ~ ~I 
Pre-Repheelites Semple Web 
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Or, if the folder is open, 

3c. Release the mouse button when the Icon's outline is within the boundartes of the open folder window. 

Aubrey Beerd:iley Beerd:iley av 

~ ocs/Beardsle /TermPaper 

Pre-Repheelites Sample Web 

Decadence 

Aubrey Beardsley Beard:iley OV 

~ ocs/Beardsle /TermPaper 

Pre-Rapheelites Sample Web 

Decadence 

Aubrey Beardsley Beard:iley av 

~ ocs/Beardsle /TermPaper 

Pre-Raphaelites Sample Web 

f2] [L) 
Decadence • ... 

When you release the mouse button, the document will have moved into that folder. 
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Moving Multiple Icons (Shift Click Method) 
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1. Click on one of lhe icons to be moved. 

It will be highlighted in black. 

2. Hold down the Shift key and click once on each of the additional icons to be moved • 

All the icons you wish to move should be highlighted in black. The Shift key is 
used to extend selections. 

3. Release the Shift key. 

4. Position the pointer over any one of the selected icons, press and hold the mouse button, and drag the Icons 
to desired location. 

The icons will move as a group "in formation." 

5. Release the mouse button. 

The icons will be in their new location. 

• • Dickens-Humor Dickens_Popular 

1:1111 
Dickens-Religion 
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Moving Multiple Icons (Bounding Box Method) 

1. Position the pointer above and to the left of lhe group to be moved. 

This method is useful for selecting a group of icons in close proximity to one an­
other. 

2. Hold the mouse button down and drag 
diagonally to the lower right comer of the 
group. 

A rectangular bounding box 
will follow the movement of the 
mouse. 

Dickens-Humor Dickens_Populer Dickens_London 

Dickens_Reform Dickens-Religion 

3. Release the button when all desired Icons are enclosed in the box. 

The bounding box will disappear and all the icons entirely within the bounding 
box will become highlighted in black. If an edge of the bounding box borders one of 
the icons too closely (even though it might appear to be fully within the box) that 
icon will not be selected and will not move with the group. To avoid this problem, 
draw your bounding box with margins of at least an eighth of an inch from the 
icons to be enclosed. 

4. Position the pointer over any one of the selected icons, press and hold the mouse button, and drag the Icons 
to desired location. 

The icons will move as a group "in formation." 

S. Release the mouse button. 

The icons will be in their new location. 
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C. Renaming Documents, Webs and Folders 

Frequently it is useful to rename documents, webs and folders you 
have created. Renaming is done by editing the name associated with 
the icon of the item you wish to rename. Only closed documents, webs 
and folders may be renamed. 

1. Select a documen~ web or folder Icon 

You will only be allowed to rename documents, webs and folders that you have 
permission to edit. In addition, the document, web or folder must be closed. The 
icon will appear grayed in the folder if the document, web or folder is currently 
open on the desktop. 

2. Cilek once within the title to set an Insertion point or drag through the text you wish to change. 

If you set an insertion point, you can type to add characters or backspace to delete 
them. If you drag through the entire name of the document, you can then type new 
text which will replace the old name. If you double-click on one word of the name, 
the word will be selected. You can then type to replace the entire word. 

D. Deleting Documents, Webs and Folders 
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To delete a document, a folder or a web, you first select an icon and 
then choose the "Delete Document" command. Be careful when using 
this function as it cannot be undone. If you delete a document with 
links to other documents, the links emanating from the deleted docu­
ment will be removed along with the document, although the blocks at 
the other ends of the links will remain intact. If you delete a web, all 
links and blocks created in the context of that web will be deleted. Since 
folders may contain other folders, documents or webs, all enclosed 
items will be deleted along with the folder you select; however, you are 
always informed of the names of all items that are contained in the 
folder. 

1. Select the documen~ folder or web you wish to delete. 

The icon representing the document, folder or web you wish to delete wili be high­
lighted in black. Only closed documents, webs or folders may be deleted. 
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2. Choose "Delete Document" from the flle menu. 

If you have selected a document or a web icon, a dialog box will appear, asking 
you whether you are sure you want to delete the document or web. Click "OK" if 
you are sure, and "Cancel" if you are not. 

If you have selected a 
folder, a different dia­
log box will appear that 
lists the name of the 
folder plus all nested 
folders, documents and 
webs. You may either 
cancel the operation or 
choose the "Delete All" 
button from the dialog 
box. 

If you do not have per­
mission to delete any 
one of the items in the 
folder, or if one or more 
of the enclosed docu­
ments is currently be­
ing edited by someone 
else, you will not be al­
lowed to delete the 
folder. 
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The following 1 O folders and files will be deleted: 

Architecture 
Transportation 
Highways in America 
Highways 
Railway Map 
Train In America 
Railroads 
Transportation 

PIH_~ 
WEB 
WORD mm 
FOLD mm 
DRRW !~m (Deletel'll) 
WORD mm "\ 
FOLD i!I!!! 
URL ~! ( Cancel ] 

'--~~~~~~~~~~~~---""-' 

The folder could not be deleted because it contains 
the following 3 locked files: 

Highways in America 
Transportation 
Technology Oueruiew 

Folders 

WORD Q 
URL 
DRRW 
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4. WEBS, BLOCKS AND LINKS 

Webs 

Blocks 
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Material stored in IRIS Intermedia documents can be connected 
together to form large or small collections of linked information. These 
collections, which can be viewed and edited by single or multiple users, 
are called webs. Blocks are discrete units of information that you may 
identify in any IRIS Intermedia document when you are in the context 
of a web. Blocks serve as the source and destination for links, which 
provide bidirectional connections between units of information. Links 
should be used to establish concrete relationships between blocks 
created in any of the IRIS Intermedia applications. The sections Using 
InterWord, Using InterDraw, and Using InterVal provide specific 
details on creating blocks and links to and from documents created 
with InterWord, InterDraw, and InterVal, while this section provides 
some general rules and methods for working with blocks and links 
within a web. 

Webs provide the context in which blocks and links exist. If you wish to 
work with blocks and links, you must create a new web or open an 
exsiting one. When a web is open, it is represented by a Web View. You 
must have a Web View open in order to create, modify or manipulate 
blocks or links. When the Web View window is closed, all the blocks 
and links created within the context of that web will disappear from 
any documents still open on the screen. 

It is possible for a document to have blocks and links in more than one 
web, although only one web can be open at a time. For example, you 
may wish to link together a set of related works by Shakespeare to 
trace his use of color imagery. Another user at your site may decide to 
create a whole different set of links connecting the same information. 
When your web is open, you would not see the other user's 
connections; those links exist in the context of a different web. Instead 
of storing your links separately in two different contexts, you could 
alternately share a single web. In this case, you could view and follow 
one another's links, plus the links of any other users who are sharing 
the same web or collection of blocks and links. 

A block can be as small as an insertion point or as large as an entire 
document; it may serve as the source or destination for one link, or for 
several links. Any selection that you can make in a document can be 
turned into a block. For example, in an InterWord document, a block 
could be a single character, a word, a paragraph, or a group of 
paragraphs. The text (or graphics objects or segments of timelines) 
that you choose to associate with a block is referred to as the block's 
extent. The extent is indicated in different ways depending on the 
application being used. For example, it is indicated by light gray 
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Links 

handles in InterVal and InterDraw, and by a marquee (flashing 
outline) in InterWord. 

The existence of a block is signalled by a marker. Some applications 
may have slightly different methods for displaying markers, but the 
block marker symbols are the same for all applications (see 
illustration below). For example, in InterWord documents, markers 
are placed above the first character of a block, and in InterDraw 
documents, markers are placed above the first object selected as part of 
the block's extent. 

Every block has an associated property sheet. The information in the 
property sheet includes the block author's name and the block's date of 
creation. In addition, each block has an explainer or name which 
helps you to identify a block in a list of blocks. 

To operate on a block, the user must select the block's marker. 
Selecting a block marker allows the user to do such things as delete 
the block, start or complete links, show the blocks's extent, or access 
the block's property sheet. 

El Block Marker 

El Block Marker with Link Symbol 

The existence of a link is signalled by a block marker containing a link 
symbol. If there is no link symbol, then there is no link from this point. 

Once you have created links, you may traverse those links. That is, you 
may travel from the source block to the destination block or vice versa. 
To follow a link, you must select the block marker indicating the 
existence of a link. There is no limit to the number of links you can 
attach to a block, but only one link may be followed at a time. If you 
select a marker which represents more than one link, you will be 
given a list of the links associated with the block from which to choose. 

A. Creating a New Web 

Creating a web provides you with a new context in which to create 
blocks and links. 

1. Select "Close All Documents" from the File menu. 

A web will not open if there is a web or any documents already open. 
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2. Pick ''New'' from the File menu. 

The "New" window will open. 

3. Select the web icon from the ~~~D~~~~~~~~N~e~w~~~~~~~~~i 
"New" window. ! 

The icon will be high­
lighted in black when 
selected. 

4. Pick "Open" from the Fiie menu. 

~ 
folder 

(Jg 
Val Ora"" Word 

A Web View window will appear 
(see Subsection M. Using a Web 
View for further information). An 
alternate method of opening a new 
Web View window is to double-click 
on the web icon in the "New" 
window. If you attempt to open a new 
web while one is already open, a 
dialog box will appear informing 
you that you must close the open web 
before opening another. 

:o Untitled5: Web Uiew 

5. You may now open documents and create blocks and links. 

Instructions are provided in the following sections. 

B. Opening an Existing Web 
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Once a web has been created, it can be opened for browsing or editing. 
It is only possible to have one web open at a time. If you plan to work 
with blocks and links, be sure to open the web before opening 
documents. If the documents are opened before the web, they must be 
closed and reopened in order for their markers to appear. 

1. Select a web Icon. 

The icon will be highlighted in black. Be sure you have closed all open documents. 
Use the "Close All Documents" command from the File menu if you have many 
documents open. 
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2. Pick "Open" from the File menu. 

A.."11 alternate method of opening an existing web is to double-click on the web's 
icon. If this is the first time you have opened the web, the Web View will display 
information indicating the number of documents and links in the web, an icon of 
the web and a timestamp. If you have previously opened this web, then the Web 
View will open and display the information that was saved the last time you 
closed the web. Subsection M. Using a Web View provides information about 
interacting with the Web View. 

C. Creating Blocks 

Remember that blocks and links only exist within the context of a web; 
therefore, before following the steps below, be sure a web is open. 

1. Open an existing document 

Select a document that already contains some text or a diagram. 

2. Select the text or graphics objects you Intend to make Into a block. 

Text will be highlighted 
in black; handles will 
appear around graphics 
objects and timeline 
events. Refer to the sec­
tions on Using lnter­
Wo rd, Using Inter­
Draw and Using Inter­
Val if you are unsure 
how to select any of 
these. 

3. Pick "Create Block" from the 
lntermedia menu. 

A block marker will 
appear above the first 
character of a block of 
text or above and to the 
left of graphics objects 
or timeline events. 
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Rpollo 15 Mission Summary 
13 
Summary of Apailo lS 

Rpollo 15 Mission Summary 
13 
Summary of Apailo lS 

s I 
Crew: David R. Scott, Commander (CDR) 1,1.1.l.1.l. 

James B. Irwin, Lunar Module. Pilot (LMP) 
il~!il AlfredJ. Worden, Command Module. Pilot (CMP) •••II: 

111111 Lmmdt: July 26, 1971 
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D. Selecting Markers 

To delete a block, show its extent or edit its properties, you must first 
select the marker associated with the block. In the InterWord 
application, the marker is always located over the first character of the 
block. In other IRIS Intermedia applications, the marker either 
appears over a character or near the objects that make up the block. 

Selecting a Marker 

1. Position the pointer over the block marker. 

The pointer is positioned properly when the point of the arrow is directly over the 
rectangular box that contains the marker. 

2. Click the mouse button to select the marker. 

When the marker is properly selected, it will become highlighted in black. 

Crew: lvid R. Scott, Commande:c (CDR) 
Jam es B. Irwin, Lunar Module Pilot (LM P) 
AlfredJ. Worden, Command Module Pilot (CMP) 

i::::::i 

Crew: David R. Scott, Commande:c (CDR) 
Jam es B. Irwin, Lunar Module Pilot (LM P) 
AlfredJ. Worden, Command Module Pilot (CMP) 

Selecting Multiple Markers in Text 
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The methods for selecting a single marker in InterDraw or InterVal documents 
are identical to those for InterWord documents. The techniques for selecting more 
than one marker, however, are slightly different. 
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1. Select a portion of text which contains several markers by dragging over It 

The text will become highlighted in black, and the markers within the text will 
become highlighted as well. To select text in lnterWord, position the pointer before 
the first character you wish to select, press and hold the mouse button, and drag the 
mouse. As you drag, text will highlight. Release the mouse button when the text 
containing the markers is highlighted. 

~D Apollo 15 Mission Summary 

Summary of Apollo lS 

Selecting Muniple Markers in Graphics 

1 a. Select one of the markers. 

Use the technique described above for selecting a single marker. 

2a. Hold down the Shift key. 

The Shift key is often used to extend selections. 

3a. With the Shift key held down, click once on each of the other markers. 

As you click on each marker, it will become highlighted in black. 

2. Using IRIS lntermedia 

Simple Cell 

Endoplasmic Reticulum 
Cell Wall 
Vacuole 
Lysosome 
Mitochondria 
Nucleus 
Golal ~paratus 
Olloroplast 
PLANT CELL 
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Or. .. 

1b. Draw a bolllding box around any nuni>er of markers. 

Use the technique described in Moving Multiple Icons (Bounding Box Method) in 
Section 3. Folders, Subsection B. Moving Icons to draw the bounding box. All 
markers and objects completly within the bounding box will be selected. 

E. Editing Block Properties 
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IRIS Intermedia gives you the option of assigning explainers­
descriptive text-to your blocks either as you create them or at some 
later time. These explainers, plus additional information about the 
block, are stored in property sheets. Block Property Sheets may or may 
not appear automatically when you create a block. (See Subsection L. 
Setting Viewing Specifications) Whether you assign explainers to 
blocks as you go along or not, you may eventually want to edit or review 
them. You may also want to look up who created a particular block or 
discover when the block was created. 

1. Select one or more block markers. Choose "Block Properties ... " from the lntermedla menu. 

A Block Property Sheet will appear. A list of all the blocks contained in your 
selection appears at the top of the property sheet dialog box with the first one 
selected. Under the block list is a field that allows you to edit the selected block's 
explainer. If a block is new, its explainer will consist of a number automatically 
assigned by the system. The Block Property Sheet also contains the date, the time, 
and the user I.D. of the person who created the block. If only one explainer appears 
under the "Blocks" heading, continue to step 3. 

2. To select a different block to 
view and edit, click on Its 
explainer in the list under 
"Blocks." 

The information about 
that block will appear 
in the "Explainer," 
"Creation Date" and 
"Author" fields below 
the block list. The only 
information you may 
change is the explainer. 

BLOCK PROPERTIES 

Blocks 

Alfred J. Worden IOI 

J11mes B. Irwin " 

EHpl11iner 

Cre11tion D11te: Fri Jan 13 09:57:49 1989 

Author. ny 

[Apply & Close J ( Apply ) C11ncel 
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3. Edit the explainer. 

The text of the current explainer is automatically selected, so to replace it, simply 
type a new explainer. It's a good idea to keep the text of your explainers as short as 
possible. (The absolute limit is eighty characters.) Also, keep in mind that block 
explainers almost always appear in dialog boxes or web views preceded by the 
name of the document in which they are contained. This means that it is not 
necessary to repeat the name of the document in the explainer. The most 
meaningful explainers are ones that succinctly describe the content of the block 
extent. 

4. Click on the "Apply" or the "Apply & Close" button. 

Both of these options associate the new explainer with the block highlighted in the 
block list. Use "Apply" when you would like to edit explainers of other blocks in 
the list and "Apply & Close" when you are finished editing or reviewing block 
explainers. The "Apply" button leaves the dialog box open. After clicking on 
"Apply," you may select another block from the block list to edit. Be sure to use the 
"Apply" button after you edit each block explainer. 

BLOCK PROPERTIES 

Blocks 

Alfred J. Worden IO 

James B. Irwin 

EHplalner I Oauld R. Scott 

Creation Date: Fri Jan 13 09:57:49 1989 

Author: ny 

[ Apply ) ( Cancel 

Note: If you edit a block explainer and click on another block from the block list 
without first picking "Apply," your editing changes will not be saved. 

F. Showing the Extent of a Block 

When you create blocks, you select text or objects which make up the 
block's extent. If you would like to see the text or objects that comprise 
a block, select the block marker and choose "Show Block Extent" from 
the Intermedia menu. 

1. Select one or more block markers. 

Use the techniques described in Subsection D. Selecting Markers. 
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2 Pick "Show Block Extent" from the lntermedla menu. 

If you selected a single marker, the text or objects which make up the block's 
extent will be highlighted. The method of highlighting block extents varies in IRIS 
lntermedia applications. For example, objects are highlighted with small gray 
boxes called handles in lnterDraw and lnterVal documents, and are highlighted 
with an outline called a marquee in InterWord documents. You will notice that 
the extent of the blocks at the destinations of links are highlighted automatically 
when you follow links (see Subsection I. Following Links). 

If you selected more than a single marker, you will be asked to choose one block 
from a list of block explainers. It is only possible to view the extent of a single 
block at a time. 

PlelllSe choose a block 

James B. Irwin 

- (Cancel) 

G. Deleting Blocks 
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A block you have created may be deleted at any time. See Subsection K. 
Deleting Links for instructions on how to unlink if you wish to keep the 
block intact, but remove one or more links associated with it. 

1. Select the marker of the block you wish to delete. 

The marker will be highlighted in black. 

2. Pick "Unblock" from the lntennedia menu. 

The block will be deleted and the block marker will disappear. Any links 
associated with the block will also be deleted. If, for some reason, you happened to 
select more than one block marker, you will be asked to choose which block you 
would like to delete. Only one block may be deleted at a time. 

Note: It is not possible to undo the delete block operation, so exercise caution when 
deleting blocks. 
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H. Creating Links 

Links can either be attached to existing blocks or they can be created 
without using existing blocks. In the latter case, however, the process 
of creating a link also automatically creates blocks at the source and 
destination points of the link. 

1. Create a selection of text and/or graphics, or select a block marker. 

If you are not sure how to select text or graphics in your current document, refer to 
Chapters III, IV or V. Selecting a block marker allows you to attach a link to a 
preexisting selection of text or graphics. 

2. Pick "Start Unk" from the lntermedla menu. 

A link is now pending. The text, graphics or block you selected will temporarily 
be considered the source of the link. If you selected text or graphics instead of a 
block marker, that text or graphics will become the extent of a new block once the 
link is completed. The "Start Link" command does not change the appearance of 
your document in any way. 

Before you go on to step 3. you may perform any number of actions that ar·e not 
related to link making; however, if you pick the "Start Link" command before 
you complete the pending link, your new selection will replace the previous 
selection as the source point for the link. If you close the web that is now open or 
quit the current IRIS Intermedia session, your "Start Link" command will be 
canceled. 

3. Create a selection of text and/or graphics, or select a block marker In the same or a different document 

This selection or preexisting block will serve as the destination of the link. 

4. Pick "Complete Link" from the lntermedla menu. 

A lir1k will now be established betn"een the two blocks. If you selected text er 
graphics, this selection will now be turned into a block. Block markers with link 
symbols will be placed at the source and destination blocks of the link if such 
markers do not already exist 

If the block or link creation settings in the Viewing Specifications dialog box are 
set to "Verbose," (see Subsection L. Setting Viewing Specifications), you will be 
presented with a property sheet dialog box before the link is actually completed. 
This dialog box allows you to enter explainers for either the source and 
destination blocks, or both. 
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I. Following Links 

Following a link causes the block at the other end of the link to appear 
on the screen. If that block is within a document that is already open, 
the window containing the document will pop to the top of your desk­
top. If the document is not already open, it will be opened for you. When 
multiple links are associated with a block, you will be given a choice as 
to which link you would like to follow. Only one link may be traversed 
at a time. 

The Simple Case 

1. Select a block marker containing a link symbol. 

See the illustration at the beginning of this section if you are not sure which 
symbol indicates the existence of a link. The marker should become highlighted 
in black. 

2. Pick "Follow" from the lntennedla menu. 

The document containing the block at the other end of the link will appear in a 
window on the screen and that block's marker will be selected. The block extent 
will also be highlighted. An alternate method of following a link is to simply 
double-click on a block marker containing a link symbol. 

Following a Link when Muftiple Links Emanate from the Same Source Block 
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1. Select one or more markers with llnk symbols. 

The marker(s) should be highlighted in black. 

2. Pick "Follow" from the lntennedla menu or doubl&-cllck on a selected marker. 

If more than one block is contained in your selection or if more than one link is 
attached to a block, a dialog box will appear. 

Please choose the source and then the destination 

Source Destination 

I Rlfred J. Worden IOI (ore tube Htm le IT akin the ~am let_ -~- 'I: 

Rille Edge (EUR 3 Station 9) 
Sen of Serenity (lnnding teKt) 
Twin Crater (Crater rim) ~ 

(( OK J) ( Cnncel ) 
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3. Select the source and destination of the link you wish to follow. 

The left side of the dialog box contains a list of all blocks (listed by explainer) that 
are included in your selection. The first block explainer will be selected. The list 
on the right side of the dialog box shows the destination points of each link 
associated with the selected block in the "Source" column. The items in this list 
indicate the name of the destination document, followed, in parentheses, by the 
explainer of the destination block. If the "Source" column contains only one item, 
select the document and block to which you wish to travel from the "Destination" 
column and continue to step 4. If the "Source" column contains more than one 
item, you can browse through all possible destinations by clicking on each item in 
the list of source blocks. Each time you click on a different block, the list of 
destinations will change to show you the documents and blocks at the other ends of 
the links. Locate and select the destination to which you wish to travel. 

4. Cilek on the "OK" button. 

The dialog box will disappear and the destination document will appear. The 
marker of the destination block will be selected and the block's extent will be 
highlighted. 

J. Editing Link Properties 

Like blocks, links have a set of properties associated with them such as 
the person who created the link, and the date and time of creation. 
Unlike blocks, links do not have explainers. Instead, the link property 
sheet includes the names of the documents at either end of the link 
and the names of the blocks in those documents to which the link is 
attached. As a convenience, the block explainers may be edited from 
the Link Property dialog box. If you wish to enter explainers for the 
blocks at both ends of the link while you are creating links, you can 
change the "Link Creation" setting in the Viewing Specifications 
dialog to "Verbose." (See Subsection L. Setting Viewing Specifications 
if you would like property sheet dialogs to appear automatically upon 
link creation.) 

1. Select one or more block markers with llnk symbols. Choose "Unk Properties ... " from the lntermedla menu. 

A Link Property Sheet will appear. In the property sheet, links are identified by the 
blocks at either end. Since block explainers are not necessarily unique, the 
property sheet also indicates in which document a block is located. Your current 
document is always considered the source document and all blocks in your 
selection region are considered source blocks. 
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The top portion of the property sheet consists of two lists. The "Source" column lists 
all of the blocks (by explainer) that are included in your selection (unless they do 
not have links emanating from them). In many cases there will only be a single 
block listed. If there is more than one block listed, the first one in the list will 
always be selected when the property sheet dialog box opens. The adjacent column 
shows the destination points of each link associated with the selected block in the 
"Source" list. The items in the "Destination" list indicate the name of the 
destination document, followed, in parentheses, by the explainer of the destination 
block. All the information below the "Source" and "Destination" columns refers 
to the link whose source and destination points are selected in the "Source" and 
"Destination" columns. 

If the "Source" column contains only one item, continue to step 3. If both the 
"Source" and "Destination" columns contain only one item, continue to step 4. 

2. If more than one block is listed under "Source," select the source block of the link you wish to edit 

Source 

LINK PROPERTIES 

Oestinotion 

. ____ .. _ .... _ ... _ ..... _ ...... ';:;""""'r=ml!!l!llMllUl§llll.1.11.11m1 ~•moo B. lnu;n v -

Source Document: Apollo ts Mission summary 

Source Block: I 
Destination Document: Hadley Rllle orbit 
Destination Block: ... , U-le-w-fr_o_m_o_r_b_lt _________ ___, 

Author. 
Creation Date: 

[Apply It Close J 

ny 
Fri Jan I 3 10:32:27 1989 

Apply Follow ( Cancel 

As you click on block explainers in the "Source" list, the list of destination points 
will change to show you the documents and blocks associated with the other end of 
the link. You can browse through all possible destinations by clicking on each 
item in the list of source blocks. The properties for the link represented by the 
selected source and destination will appear in the lower portion of the dialog box. 
If only one document/block pair now appears in the "Destination" column, 
continue to step 4. 
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3. H more than one document/block pair Is listed under "Destination," select one from the list 

As you click on document/block pairs in the "Destination" column, the 
information about the link will appear in the "Source Document," "Source Block," 
"Destination Document," "Destination Block," "Author" and "Creation Date" 
fields. You may only change the explainers in the block fields. 

LINK PROPERTIES 

Source 

Alfred J. Worden . : 

Source Document: 

Source Block: 

Destination Document: Twin Crater 
Destination Block: .-I C-ra_t_e_r -rl-m-------------. 

Author: ny 
Creation Date: Fri Jan 13 1 0:39:56 1 989 

[Apply & Close J Apply Follow ) Cancel 

4. Edit the source and destination block explainers. 

The text of the source block explainer is automatically selected, so to replace it, 
simply type a new explainer. Press the Tab key to advance to the destination block 
explainer field. It's a good idea to keep the text of your explainers as short as 
possible. (The absolute limit is eighty characters.) 

5. Cilek on the "Apply," "Apply & Close" or "Follow" button. 

The "Apply" and "Apply & Close" options both associate the new explainers with 
the link highlighted in the source and destination lists. Use "Apply" when you 
would like to edit explainers of other link endpoints, and "Apply & Close" when 
you have finished editing. The "Apply" button leaves the dialog box open. After 
clicking on "Apply," you may select another link from the source and destination 
lists. Be sure to use the "Apply" button after you edit each block explainer pair. If 
you edit a pair of block explainers and click on another link without first picking 
"Apply," your editing changes will not be saved. You must explicitly save each 
editing change you wish to keep by using either the "Apply" or "Apply & Close" 
buttons. 

The "Follow" button is provided as a shortcut. Clicking on "Follow" will traverse 
the currently selected link. 

If you click on the "Cancel" button, any unsaved changes will be ignored and the 
dialog box will close. 
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K. Deleting Links 

You may delete any link in the current web. Deleting a link leaves the 
source and destination blocks of the link intact, so you may attach 
different links to those blocks or you may delete them by using the 
"Unblock" command (see Subsection D. Deleting Blocks). 

1. Select the marker associated with the link you wish to delete. 

The marker should be highlighted in black. 

2. Pick "Unlink" from the lntermedla menu. 

If the selected marker only has one link associated with it, the link will be 
deleted. If it has more than one link, you will be given a dialog box identical to the 
one illustrated in Subsection I. Following Links. Select the source and the 
destination of the link you wish to delete and click on the "OK" button under the 
list. The source and destination blocks will not be deleted, only the connection 
between them is removed. It is only possible to delete one link at a time. 

L. Setting Viewing Specifications 
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Depending on your site, link and block property sheets may or may not 
automatically open for you when you create blocks or links. The 
Viewing Specifications dialog allows you to specify verbose or fast block 
and link creation. When the radio button is set to "Verbose" rather 
than "Fast," the property sheets are automatically presented when 
blocks or links are created. Any changes you make to settings in this 
dialog box will only be in effect for the current IRIS Intermedia 
session. If you would like the settings changed permanently, consult 
with your IRIS Intermedia System Administrator. 

1. Pick ''View Specs ... " from the lntennedla menu. 

The viewing specifi­
cations dialog box 
will appear on the 
screen. 

UIEUJING SPECIFICATIONS 

Block Creotion: 0 Verbose @Fost 

Link Creation: ~Verbose ® Fost 

t OK ~ Con eel ) 
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2. Choose the desired radio button. 

To make property sheets appear automatically upon block or link creation, click 
on the "Verbose" radio button by each choice. To reverse this process, click on the 
"Fast" radio button. 

If you are only making blocks and not links, then you should set "Block 
Creation" to "Verbose." The property sheet that appears is identical to the one 
illustrated in Subsection C. Editing Block Properties. If you set "Block Creation" 
to "Verbose" and you create a link, you may be presented with two Block Property 
Sheets: one after you pick the "Start Link" command and one after you pick the 
"Complete Link" command. Block Property Sheets only appear if you select text or 
graphics as the source or destination of the link. Property Sheets are not presented 
if the source or destination of a link is a preexisting block. 

If you would like to enter block explainers as you make links, the most efficient 
way is to set "Link Creation" to "Verbose." In this case, a Link Property Sheet 
(pictured below) will automatically open after you issue the "Complete Link" 
command. This property sheet allows you to enter explainers for both the source 
and destination blocks of the new link. If you attached one or both ends of the link 
to preexisting blocks, the explainers for these blocks will already be entered in the 
"Source Block" or "Destination Block" fields. Clicking on the "Apply" button in 
this dialog box will associate the explainers with the source and destination blocks 
of the link. Choosing "Cancel" will leave the explainers in the same state as when 
the dialog box opened, but the link will still be established. 

LINK PROPERTIES 

I Bloc~ 3: 36 

Source Block: 

Destination Block: 

Creation Date: Fri Jan 13 1 D:39:56 

Ruthor: ny 

~ Rpply ] 

Source Block: 

LINK PROPERTIES 

IJames B. Irwin 

Destination Block: Crater ri~ 

Creation Date: Fri Jan 13 10:39:56 

Ruthor: ny 

(1111111) 

( Cancel ) 

( Cancel ) 

2. Using IRIS lnterrnedia Webs, Blocks and Unks 81 



3. Pick the "OK" button. 

The "OK" button will 
close the Viewing 
Specifications dialog 
box and save any 
changes you speci­
fied. Choosing 
"Cancel" will dis­
card any changes you 
have made to block 
block and link cre­
ation settings. 

UIEWING SPECIFICRTIONS 

Block Creation: O Uerbose ® Fast 

Link Creation: O Uerbose ®Fast 

.. Cancel) 

M. Using a Web View: Scope Lines, Paths and Maps 
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When a web is opened, it is represented by a Web View. As long as you 
wish to view, create or manipulate blocks and links in the context of 
the current web, the Web View window must be left open on the screen. 

The Web View serves a variety of interrelated purposes. It provides 
historical information answering the question "How did I get here?," 
and also tells you about connections between documents, answering 
the question "Where can I go from here?" The Scope Line, located just 
below the window's Title Bar shows you how many documents are 
included in the web and how many links exist between those 
documents. This gives you an idea of the size or "scope" of each web. In 
addition, the Web View also offers a number of facilities to help you 
browse through a linked set of documents. From the Web View you can 
both open documents and follow links; the instructions below show 
how this can be done. 

As you open documents from folders, from the Web View or by 
following links, their icons will appear in the Web View window. Each 
icon will be timestamped indicating when the event occurred. These 
icons will remain in the Web View window to form the Path. This Path 
allows you to see which documents you have visited. For example, 
every time you follow a link, the action along with the destination of the 
link is recorded for you in the Path. This provides you with a sense of 
where you are within the web as a whole, and makes it possible for you 
to retrace your steps easily. The Path portion of the Web View presents 
document icons in a sequential list of events. Each time you open a 
document, follow a link, or activate an inactive document, your action 
is automatically recorded with a transition marker. There are three 
such transition markers: 
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6IJ tells you that you opened a document, 

~ tells you that you followed a link to a document, and 

[El tells you know that you reactivated a document window that was 
already open on the desktop. 

If you decide you want to return to a document you've previously 
opened in your session, you can go back to it by double-clicking on the 
mini-icon in the Path portion of the Web View. The Path is also saved 
between sessions so that you can review your activites from your . . 
previous session. 

1 2 links in w•b - Scqie Lile 

Open Document Markar--Eil 
ra:J D•c<idtnc• Ovtrvit'W' -- Docuna1I Name 
Tu• May 3 16 :26 : 15 1 988 and Tineslamp 

Readlvatll Document Mmk•--'1 ... 
[IDe.ardsJ.y Ov•rvt•w 
Tut May 3 16 :26 :20 1 988 

Follow Merka'-~ 

[IDe.ardsley Portnit (Block 2) 
Tut M<iy 3 16 :26 :44 1988 

~ .... 
g B.ardsl•Y Ovtrvi•w 

Tut M<iy 3 16 :26 :46 1988 

Li*Liw 

~ Aubrey Beardsley 

g· Burdsley Portnit 

/._ 
8 D•cadtnce Ov•rvitw 

ii Prt-R<iphat lit ts 

"Mft.lccn 

Path 

Map 

While the Path shows you the route you took to arrive at the current 
document, the Map tells you where you can go next. The last item in 
the Path (the most recently active document) is drawn with lines 
connecting it with icons of each of the documents to which it is linked. 
As with Path icons, you may double-click on any Map icon to open the 
corresponding document. In addition, selecting a block marker with a 
link symbol in the current document will highlight the corresponding 
link lines in the Map, letting you know which document or documents 
you could open by double-clicking on the selected marker. 

It's a good idea to place the Web View window in a location on the 
screen where you can easily refer to it. 
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Browsing through Linked Documents 

1. Open a document. 

Be sure a web is open. An icon representing the document will appear in the Path 
portion of the Web View window. If you open a new document or one that does not 
contain blocks and links, nothing more will happen. If the document you opened 
contains links created in the context of the web which is open, then, in addition to 
being added to the Path, the document will be shown with lines to other icons 
representing documents to which the active document is linked. 

2. Follow a link or open another document from a folder. 

With each successive document opening, the Web View will redraw, adding the 
newly opened document to the end of the Path. If appropriate, the Web View will 
also provide a Map of all the documents connected to the one you have opened. 

Link Previewing 

The Map portion of the Web View may be used as a method for previewing link 
destinations. If a document with links is active, you can determine the name of 
the document containing the destination block(s) of any selected marker. 

1. Open a document containing more than one link. 

Position the document window so that you can see the contents of the document and 
the Map portion of the Web View at the same time. 

2. Select a block marker with a link symbol. 

One or more link lines in the Map will be highlighted, indicating the destination 
document or documents at the other end of each link associated with the selected 
marker. 

3. Select a different marker. 

Now see which link lines are highlighted. 

Opening a Document from the Path or Map 
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Suppose you would like to go back to a document you were looking at earlier or 
would like to go directly to a document displayed in the Map. 
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1. Position the pointer over a Map or Patil entry In the Web View. 

Be sure the cursor is directly over a Path or Map entry. In the Path, this refers to 
an icon plus the corresponding document name, transition marker, and 
timestamp. In the Map, the entry is simply an icon and the corresponding 
document name. 

2. Click tile mouse button. 

The event will become 
highlighted in black. 

3. Pick "Open" from the Fiie menu. 

Double-clicking on the 
Path or Map entry is 
another method of 
opening a document 
from the Web View. 

Following Links from the Web View 

Sample Web 
7 docum•nts in w•b 

5ilro·1 
~Dtcadence Overvitw 
Tut Ma1:1 3 16:26:15 1'388 

Iii --· ~ro·1 
~Btardslt11 Portrait (Block 2) 
Tut M;l\I 3 16:26:44 1988 

~ .... 
g Btardslt\I Overvitw 

Tut M;l\I 3 16:26:46 1988 

~ Aubr•y Bnrdslfll 

o· Btards'M\I Portrait 

1 2 links in wtb 

Opening a document from the Web View always places you at the beginning of the 
document. Sometimes, however, you may want to go directly to the block at the 
other end of a link displayed in the Map portion of the Web View. If the Web View 
window is active, you can follow links by double-clicking on link lines in the 
Map. This is particularly useful if the document at the end of the link is long or 
complex. 

1. Position tile cursor over a link line In tile Map. 

Be sure the pointer is directly over the line. 
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2. Ciiek the mouse button. 

The link line will become highlighted. 

Sample Web 
7 documents in web 12 links in web 

6i1ro1 
t.8Joec.adence Overview 
TueM.a1,1 316:26:151988 

~fo'I 
t.8Jeeards1ey Overview 
Tut M.a1,1 3 16:26:20 1988 

~101 
t.8Jeeardsley Portr.ait(Block 2) 
Tue M.ay 3 16 :26 :44 1988 

lf:L. 
g Btardslt\I Overview 
Tu• M~ 3 16 :26 :46 1988 

0 D•c.adtnce Overview 

;;, Pn-R.aphulites 

3. Choose "Follow" from the lntermedla menu. 

Double-clicking on the link line is an alternative way of traversing the link. 

The document corresponding to the link line will open and will scroll to the block 
which serves as the endpoint of the link. If there is more than one link from the 
current document, you can select the one to follow from the dialog box that wi11 
appear. The link marker at the endpoint of the link will be selected and the block 
extent will be highlighted. 

N. Saving a Web 

1. Activate the Web View window when you wish to save It 

The Title Bar should have horizontal black lines. 
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2. Pick "Save" from the File menu. 

A dialog box will appear to alert you that documents to which you have added 
blocks and links will be saved before the web is saved. Saving the web is a 
convenient way to save all open documents to which you have added blocks and 
links. 

n 

Documents which added 
blocks and/or links will be 
saued before sauing web. 

C1mcel ) 

3. Ciiek on the "OK" button. 

If the web you are saving had been previously saved, the cursor will turn to a 
wristwatch while the web and any other unsaved documents are saved. Wait for 
the arrow cursor to reappear before continuing to work. Skip step 4. 

If you have not previously saved the web, a dialog box will appear requesting a 
title for the web. 

Saue this document as: 

Soue Cancel 

4. Type In a title and click ''Save." 

The new web will be saved. You will see a web icon appear in your current folder, 
and the name you entered will appear in the Title Bar of the Web View window. 
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0. Closing a Web 

Or ... 
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When you are ready to stop working or when you wish to open a 
different web, you must first close the web which is currently open. 

1a Close the Web View window by clicking In its Close Box. 

The "Close" command from the File menu can also be used. When a Web View 
window is closed, any block markers contained in open documents will 
disappear. If you would like to follow, create or manipulate blocks and links, you 
must close all open documents, reopen the web, and then reopen any relevant 
documents. 

1 b. Choose "Close All Documents" from the Ale menu. 

The web and all its documents will be closed. If you have made changes to any of 
the documents, or added or deleted any blocks or links in the web, you will see a 
dialog box asking if you wish to save these changes. Click on the appropriate 
button in the dialog box. If this is the first time the web has been closed, you will be 
given a dialog box asking you to specify a title for the web (see Subsection N. 
Saving a Web). Once the web is closed, you must reopen it to edit blocks or 
traverse links associated with that web. 
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5. USER AND DOCUMENT PROPERTIES 

User properties provide information about the current user, including 
login ID, address, home folder, and group membership. Each 
document created within IRIS Intermedia is also assigned a set of 
properties. Document properties determine the access rights of a 
document (which tell who is allowed to read, annotate and edit a 
document), and also provide other information about a document such 
as its size, the name of the folder in which it resides, etc. 

A. User Properties 

The User Properties sheet 
contains two parts: a property 
list and group information. 
The latter is interactive. 

The User Properties dialog 
box provides you with infor­
mation about the person who 
currently is logged in and 
running IRIS Intermedia. 
This is usually yourself. The 
information, contained in the 
top portion of the dialog, in­
cludes login ID, user name, 
address, phone number(s), 
and home folder. 

USER PROPERTIES 

User. nkm 
Full Neme: Norman Meyrowltz 
Rddress: 212 Derting 
Phone 1: 0000 
Phone 2: 5554545 
Home: /lrwln/nkm 
Member or other Q Groups: project 

scholars 
source 5 

Members: 
........... 1 

~ 

' OK D 

The last two items in the property sheet give you information about 
access rights groups. The first, "Member of Groups," tells you to which 
access group(s) you belong. Your group membership will determine 
the rights you have to edit, annotate and read IRIS Intermedia 
documents. The second, "Other Group Members," informs you who 
else is in your group(s) (see Subsection B. below for a discussion of 
access rights). 
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Using the "Member of Groups" and "Other Group Members" Properties 

1. Select "User Properties" from the lntermedla menu. 

The groups of which you are a member will automatically be listed in the 
"Member of Groups" category. In many cases, you will only be granted 
permission to edit a document if you are in the group associated with the 
document. The group ownership of a document can be determined using the 
Document Properties dialog (see Subsection B. below). 

2. Click on the name of a group to which you 
belong. 

It will become highlighted in 
black, and the members of this 
group will appear next to "Other 
Group Members." 

3. When you are done examining group 
information, click "OK" to close the User 
Properties dialog. 

User: 
Full Nome: 
Rd dress: 
Phone I: 
Phone 2: 
Home: 
Member of 
Groups: 

Other Group 
Members: 

USER PROPERTIES 

nkm 
Norman Meyrowltz 
212 Oorling 
0000 
5554545 
/lrwln/nkm 

other r project 
.. ,,.. I • 

source "' IO 

inter ~ 
nkm 
tjc 

Ii} 

~ OK ~ 

B. Document Properties 
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The Document Access 
Rights & Properties dialog 
box has two basic parts: 
the access rights portion, 
which is editable, and the 
property list, which is for 
informational purposes 
only. 

DOCUMENT ACCESS RIGHTS II' PROPERTIES 

Protect Write Annotate RBBd 

1111: D D 181 181 
Group: 181 181 181 181 
Owner: 181 181 181 181 
Inter: 181 181 181 181 

Folder: /lrwlnlO/mergedoc1.CT/Lunar Geology 
Document: Moon Sites 
ID: 796 
Type: DRAW 
Owner: kes 
Group: scholan 
Size: 16259 
Lest Access: Mon Feb 6 15:18:341989 
Modified: Mon Feb 6 15:18:07 1989 

( Cancel 
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The Property List 

The property list portion of the Document Access Rights & Properties dialog box 
provides useful information about a document. You can determine the name of a 
document, the name of the folder in which it resides, the ID number of the 
document, the type of document it is (lnterDraw, lnterWord, etc), the owner, the 
access group, the size of the document, and the dates at which the document was 
last accessed and modified. This property list occupies the lower portion of the 
dialog. 

Folder: 
Document: 
ID: 
Type: 
Owner: 
Group: 
Size: 

/irwin 1 O/mergedocs.CT /Lunar Geology 
Moon Sites 
796 

DRRW 
kes 
scholars 
16259 

lost Recess: Mon Feb 6 15: 18:34 1989 
Modified: Mon Feb 6 15:18:07 1989 _, 

Cancel 

1. Select the Icon of the document whose document properties you wish to examine. 

The document can be either open or closed. If it is open, changes made in the 
dialog box will not take efect until the document has been closed and then 
reopened. 

2. Choose "Document Properties ... " from the lntermedia menu. 

The Document Access Rights & Properties dialog box will open. 

3. Click on the "OK" button when you are finished examining the different document properties. 

You cannot alter any of the property list items; the access rights are the only part 
of the dialog box you may modify. These are explained below. 
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Access Rights Settings 

92 

When a new document is created, it is automatically assigned to the same group 
as the folder in which it resides. The property list in the Document Access Rights 
& Properties dialog box permits you to look up the individual ownership and group 
affiliation of a document, while the User Properties dialog, described in 
Subsection A., allows you to determine whether or not you are in the same group as 
the one affiliated with the document and who else is in that group. With this 
information, you can now use the access rights portion of the document properties 
sheet to determine the rights you have to a document and the rights others have to 
that document. 

Note: There is currently no way within IRIS lntermedia for users to change their 
group membership or the group ownership of folders or documents. The IRIS 
Intermedia System Administator should be able to make these changes for you. If 
you plan to coauthor documents with other users, the best strategy is to ask the 
System Administrator to set up a new user group. He or she should then add each 
of you to the new group and create a common folder with the new group affiliation 
in which you and the others can create documents. 

The system recognizes four categories of users: All, Group, Owner and Inter. 
"Inter" refers to the System Administrator, who retains the ultimate authority over 
setting and changing access rights. No one can change the "Inter" access rights; 
they appear in the dialog box for informational purposes only. "Owner" refers to 
the person who created the document, "Group" refers to anyone in the group 
affiliated with the document, and "All" refers to all IRIS Intermedia users. Using 
the information in the User Properties dialog, you can determine whether your 
access category is "Owner," "Group," or "All." For most documents, users in the 
"All" category have the most restricted access rights. Access rights for users in 
the "Group" category are calculated by adding together the rights assigned to 
"All" and "Group," and access rights for the owner of the document are calculated 
by adding together the rights assigned to "All," "Group," and "Owner." 

In addition to the categories of users, there are four types of access rights: Protect, 
Write, Annotate and Read. "Protect" access refers to the ability to change the 
access rights settings associated with a document. "Write" access refers to the 
ability to edit the contents of a document. "Annotate" access is the ability to add or 
delete blocks and links or to make any other changes to the document using the 
Intermedia menu. "Read" access allows the user to open the document, view its 
contents, and follow links. 

Any number of IRIS Intermedia users may annotate or read a document at the 
same time; however, only one user at a time may edit a document. If another user 
tries to change a document while you are changing it, he or she will get a message 
indicating that the document is locked. A lock is placed on the document as soon 
as you make any editing change. The lock is not released until the document is 
closed. Saving the document will not release the lock, so if you are working 
jointly on a document \Vith other people, be sure to close it when you have finished 
your editing changes. If you reopen it without making any modifications, 
someone else will now be able to edit that document. 
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Determining Access Rights in a Document 

1. Select the icon of lhe document whose document properties you wish to examine. 

The document can be either open or closed. If it is open, changes made to access 
rights will not take effect until the document has been closed and then reopened. 

2. Choose "Document Popertles. .. " from the lntennedia menu. 

The Document Access Rights & Properties dialog box will open. 

3. Examine the dialog box to determine 
the types of access rights granted to 
each group of users. 

DOCUMENT ACCESS RIGHTS & PROPERTIES 

Horizontal rows of boxes refer 
to categories of users; vertical 
lines of boxes refer to 
categories of access rights. 
Boxes marked with an "X" in­
dicate the current access rights 
settings. If no "X" appears in a 
box or any box directly above 
it, that category of user has no 
right to perform that particular 
activity. 

Protect Write Rnnotnte Read 

All: D D 181 181 
Group: 181 181 181 181 
Owner: 181 181 181 181 
Inter: 181 181 181 181 

Folder: /Irwin 1 O/mergedoc1.CT/Lun11r Geology 
Document: Moon Sites 
ID: 796 
Type: DRAW 

Owner: Ices 
Group: scholars 
Size: 16259 • 
lnst Recess: Mon Feb 6 15:18:34 1909 
Modified: Mon Feb 6 15:18:07 1989 

( Cencel 

The illustration above shows the access rights portion of the dialog box with its 
default settings for newly created documents. The settings in the first row ("All") 
indicate that all IRIS Intermedia users have permission to read and annotate the 
document, but they have no rights to edit or change the protections for the 
document. The other three categories of users ("Group," "Owner" and "Inter") 
have less restricted access than those in the "All" category. The owner of the 
document ("kes" in this example), users who are members of the document's 
group (the group "scholars") and the System Administrator may change the 
document's access rights, edit or annotate the document and read the document. If 
you wish to change the default access rights settings for new documents, see 
Changing Default Access Rights below. 
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Revising Access Rights 

94 

Any user with "Protect" access to a document can change the document's access 
rights settings. The ability of a given category of user to change access rights is 
determined by looking in the "Protect" column of the Document Access Rights & 
Properties dialog box. 

1. Select a document Icon and open the Document Access Rights & Properties dialog If it Is not already open. 

The dialog box will open. 

2. Detennine your user category. 

Unless you are the System Administrator (your login ID would be "inter"), you 
will be in one of the three other user categories. First check to see if you are the 
owner of the document by looking it up in the property list portion of the dialog box. 
If you are not the owner, check the group affiliation of the document in the property 
list. Are you a member of that group? If you are, your user category is "Group." If 
you are not sure if you are a member of the group, close the dialog box, open the 
User Properties dialog box and see if the group name appears in the list next to 
"Member of Groups." Reopen the Document Access Rights & Properties dialog box. 
If you are not a member of the document's group, you are in the "All" user 
category. 

3. Check the access rights portion of the dialog box to detennlne whether your user category has "Protect" 
access. 

If the "Protect" box in your user category row or in any row above it has an "X," 
you can revise the access rights settings for the document that you selected. If you 
do not have "Protect" access to the current document, you will not be able to make 
any changes in this dialog box. If this is the case, skip to step 5. 

4. If you have "Protect" access for this document and wish to revise any of the access rights settings, click In 
empty boxes to set new access rights and click In boxes already containing an "X" to remove access rights. 

An "X" will appear where you have added access rights, and the box will become 
empty where you have removed them. In some cases, described below, adding or 
removing one type of access rights will automatically alter other settings. 

If you have "Protect" access to the document, you may change the "Protect" access 
of one or more categories of users in order to provide or remove their ability to 
revise access rights to this document. Be careful that you do not remove your own 
ability to change the access rights of the document. 

User and Document Properties 2. Using IRIS lntermedia 



The illustration demonstrates 
changing the "All" category's 
ability to edit a document by 
giving that category "Write" 
access. Any user from the 
"All" category will now be 
able to edit the document in 
addition to reading and anno­
tating it. In order to make this 
change, you would have to be 
in the appropriate group, the 
owner of the document or the 
System Administrator. 

DOCUMENT ACCESS RIGHTS & PROPERTIES 

All: 

Group: 

Owner. 

Inter: 

Protect 

0 
181 

l8l 
181 

Write 

~ 
181 

l8l 
l8l 

Rnnot11te Re11d 

~ 181 
181 181 

l8l l8l 
l8l l8l 

Folder: /Irwin I O/mergedocs.CT/Lunnr Geology 

Document: Moon Sites 
ID: 796 
Type: DRRW 
Owner: kBI 
Group: schol11rs 
Size: 16259 
Lut Recess: Wed Feb 8 11 :05:45 1989 
Modified: Mon Feb 6 15:18:07 1989 

ll OK J Cancel 

It is not possible to have "Write" access without also having "Annotate" and 
"Read" access, and it is not possible to have "Annotate" access without also 
having "Read" access. Likewise, it is not possible to remove "Read" access 
without also removing "Write" and "Annotate" access. If you add "Write" access 
to a category of user, the "Annotate" and "Read" access settings will 
automatically be turned on for that category of user if they are not already on. If 
you remove "Read" access from a category of user, the "Write" and "Annotate" 
access settings will automatically be turned off if they are not already off. 
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The illustration below demonstrates changing the "Group" category's "Write" 
access setting. Clicking in the empty box adds an "X" to the "Write," 
"Annotate" and "Read" boxes in the "Group" row. 

DOCUMENT ACCESS RIGHTS & PROPERTIES 

Protect Write Annotate Rend 

1111: D D D D 
Group: D ~ 0 0 
Owner: 181 181 181 181 
Inter: 181 181 181 181 

Folder: /lrwln10/mergedoc1.CT/Lun11r Geology 
Document: Moon Siles 
ID: 796 
Type: DRAW 
Owner: ke1 
Group: scholars 
Size: 16259 
Last Recess: Mon Feb 6 15:18:34 1989 
Modified: Mon fllb Ii 15:18:011989 

n OK J Cancel 

DOCUMENT ACCESS RIGHTS & PROPERTIES 

Protect Write Annotate Reed 

Rll: 0 D 0 0 
Group: 0 ~ 181 181 
Owner: 181 181 181 181 
Inter: 181 181 181 181 

Folder: /Irwin I O/mergedoc1.CT/Lun11r Geology 
Document: Moon Sites 
ID: 796 
Type: DRRW 
Owner: ke1 
Group: 1chol11n 
Size: 16259 
Last Recess: Mon Feb 6 15:18:34 1989 
Modified: Mon Feb 6 15:18:011989 

n OK J Cancel 
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5. Cilek on the "OK" or "Cancel" buttons to close the dialog box. 

Clicking on the "OK" button closes the Document Access Rights & Properties 
dialog box and saves the changes you have made. If you have changed the access 
rights of an open document, close and then reopen the document to implement the 
changes. Clicking on the "Cancel" button closes the dialog box and returns the 
access rights settings to what they were when you opened the dialog box. 

Changing Default Access Rights 

1. Pick "New ... " from the File menu. 

The New window will open. Selecting any icon in this window and examining its 
document properties will allow you see the default access rights settings for new 
documents. Changing these settings will change the default settings for the 
current IRIS Intermedia session. 

2. Select any Icon in the New window and pick "Document Properties ... " from the lntennedla menu. 

The dialog box will open, showing the default access rights settings currently in 
effect. Most of the items in the property list portion of the dialog box are not 
applicable when an icon from the New window is selected. 
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3. Edit the settings In the access rights portion of the dialog box. 

If your documents are works in progress and you do not want anyone else to read 
them, remove all the "X's" from the "All" and "Group" categories, as shown 
below. If you are working on documents with other members of a user group, you 
may want to remove "Annotate" and "Read" access from the "All" category, but 
retain "Write" access for the "Group" category. If you want to allow others to read 
your documents, make links to and from them, but not edit their contents, add 
"X's" to the "Annotate" boxes in the "All" and "Group" categories and remove 
"X's" from the "Write" and "Protect" boxes. If you don't remove "Protect" access, 
users will be able to reinstate their own "Write" access. Whatever changes you 
make, you will always be able to revise the settings later. 

DOCUMENT RCCESS RIGHTS & PROPERTIES 

Protect Write Rnnotate Read 

Rll: D D D D 
Group: D D D D 
Owner: 181 181 181 181 
Inter: 181 181 181 181 

Folder: New 
Document: Default Recess Rights 
ID: 

Type: 
Owner: 

Group: 
Size: 
Last Recess: -
Modified: 

(--) Cancel 

4. Click on the "OK" button to close the dialog box and save the changes. 

Every time you create a new document in the current session, the access rights for 
that document will correspond to the changes you have just made. 

Note: Changes made to default access rights settings are only in effect for the 
current IRIS Intermedia session. 
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6. PRINTING AND REFORMATIING 

Once you have examined the contents of a folder in IRIS Intermedia, 
you may wish to print out a copy of the folder as well as any number of 
documents. A series of commands in the Print menu allow you to 
format and print folders, web views and documents created with the 
InterDraw, InterWord and InterVal applications. These commands 
act only on the active window, and therefore you can only print or 
reformat the contents of one window at a time. 

Note: You cannot select an icon in a folder or Web View window and 
print the document it represents. Documents must be open to be 
printed. 

A. Reformatting Using the Print Menu 

Page Setup 

Intermedia's Print menu provides a number of commands that allow 
you to reformat before you print. These commands allow you to 
reformat the currently active folder, Web View or document. Other 
commands are designed to reformat on the screen only and will not 
affect the printed format. If "Show Breaks" has not been activated, you 
will not be able to choose either "Show Page Numbers" or "Show 
Borders." The "Print Page Numbers" and "Insert Frame" commands 
are designed to reformat for printing purposes only and will not affect 
the screen format. 

1. Choose the "Page Setup ... " command from the Print menu. 

A dialog box will appear, allowing you to specify the type of paper in the printer, 
indicate printing orientation and determine a percentage by which to reduce or 
enlarge the document. The dialog box also allows you to deselect two "Printer 
Effects." "Font Substitution" is not applicable in this version of IRIS Intermedia 
and "Smoothing" improves printing of bitmap pictures. You are urged not to 
change these two settings. 

lnserWrlter v3.1 

Pnper: C!J US Letter 0 R4 Letter 

0 US Legnl 0 85 letter 
Reduce or jlmnl '7o [ Cnncel ) 
Enlnrge: . . 

Orientation 

-~ 
Printer Effects: 
181 Font Substitution? 

181 Smoothing? 

The illustration shows the Page Setup diaiog box with its default settings. 
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2a. To change paper size, click on the appropriate button. 

Your choices are US Letter, US Legal, B4 Letter and B5 Letter. Unless the 
appropriate paper and paper tray are available for the other sizes, you should keep 
Paper set on US Letter. If page breaks are showing, they will be adjusted to reflect 
the new page size. 

2b. To change orientation, click on one of the "Orientation" icons. 

The document will still appear vertically on the screen, but if page breaks are 
showing, they will be adjusted to reflect the new orientation. 

LaserWrlter 

Paper: ® US Letter 0 R4 Letter 
0 us Leg&I 0 BS Letter 

Orient&tion 

ffimUI 
Printer Effects: 
181 Font Substitution? 
~ Smoothing? 

2c. To reduce or enlarge the documen~ type In the desired percentage. 

To decrease the size, type in a number less than 100. To increase the size, type in a 
number greater than 100. The components of the document will not become larger 
or smaller on the screen, but if page breaks are showing, they will be adjusted to 
reflect their new relationship to the components. For example, if you enlarge by 
150% a text document that exactly fills one full page, the text will appear the same 
size on the screen, but both vertical and horizontal page breaks will be adjusted to 
reflect the new pagination. 

3. Click on the "OK" button to implement changes in the active folder, Web View or document 

The dialog box will disappear and the changes will be implemented. If you click 
on the "Cancel" button, the dialog box will disappear and the settings will return 
to what they were when you opened the dialog box. 
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Margins 

1. Choose the "Margins. .. " command from the Print menu. 

A dialog box will appear, allowing you to reformat the margins. The default 
setting is 112". 

Set margins to: 

OD" 

( OK 

@1/2" 01· 011/2" 02" 

0 Printable area of page 

0 2 1 /2" 

Cancel ) 

The illustration shows the Margins dialog box with its default setting. 

2. To change the margins, click on the appropriate button. 

You may make the margins smaller by clicking on the O" or "Printable area of 
page" buttons. O" leaves no margin and may cause text or components near the 
page borders not to appear on the printed page. "Printable area of the page" creates 
a small margin but ensures that no information will be lost when the page is 
printed. You may also enlarge the margins to 1", 1 112", 2" and 2 112". 

Set margins to: 

0 O" 

OK 

@1/2" 01· 011/2" 02" 

~Printable area of page 

Set margins to: 

0 O" 0112· 01" 011/2" 02" 

@ Printable area of page 

OK~] 

02112· 

Cancel 

0 2 1/2" 

Cancel 

If page breaks are showing, they will be adjusted to reflect the printable area left 
by the new margins. For example, if you increase. the margins, thereby 
decreasing the printable area, the page breaks will move closer to the text. 

2. Using IRIS lntermedia Printing and Reformatting 101 



3. Click on the "OK" button to Implement changes in the acUve folder, Web View or document 

The dialog box will disappear and the changes will be implemented. If you click 
on the "Cancel" button, the dialog box will disappear and the settings will return 
to what they were when you opened the dialog box. 

Including a Frame 

To have each page you print framed with a black border, use the "Include Frame" 
command from the Print menu. To remove the frame, choose the same command 
when it appears with a check mark in front of it. This command is especially 
useful when printing folders because they appear without borders when printed. 

1. Be sure the document in which you want to Include a frame Is In the acUve window. 

Click in the document's window if it is not already active. 

2. Choose •include Frame" from the Print menu. 

A frame will now appear around the margins of each page of the document when 
you print it. If the command appears with a check mark in front of it, the frame 
has already been inserted. Choosing the command with the check mark visible 
will remove the frame from subsequently printed versions of the document. 

Page Numbering 

Four commands in the Print menu involve page numbering: "Start Page Number ... " 
"Top To Bottom," "Print Page Numbers" and "Show Page Numbers." ' 

Start Page Number 
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1. Choose the ''Start Page Number ... " command from the Print menu. 

A dialog box will appear, allowing you to set the page number of the document's 
first page. The default setting is 1. 

Starting page number: jl I 

DK Cnncel 

The illustration shows the "Start Page Number" dialog box with its default setting. 
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Top To Bottom 

2. To change the numbering of the first page, type In the desired page number. 

,...-----, 
Stnrtlng page number: ~ 

DK ~] Cnncel 

3. Click on the "OK" button to Implement changes In the active folder, Web View or document 

The dialog box will disappear and the changes will be implemented. If page 
numbers are showing on the screen, they will now reflect any changes you have 
made. All pages following the first page will be renumbered in accordance with 
the new first page number. If you click on the "Cancel" button, the dialog box will 
disappear and the settings will return to what they were when you opened the 
dialog box. 

This command provides you with a choice of numbering schemes in InterDraw 
and InterVal documents that are more than one page wide. You may either 
number the first column down, then the second column down and so on (Top To 
Bottom) or you may number the first row across, then the second row across and so 
on (Side To Side). When a check mark appears before the command, it signifies 
that the document is currently formatted in a Top To Bottom scheme and that 
choosing the command will change the numbering to Side To Side. 

1. Be sure that the document you wish to reformat is in the active window. 

Click in the window you wish to reformat if it is not currently active. 
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2. Choose the "Top To 
Bottom" command from 
the Print menu. 

If the command ap­
pears without a 
check mark, the 
document you wish 
to reformat will 
have its numbering 
changed from Side 
To Side to Top To 
Bottom. If a check 
mark appears be­
fore the command, 
the numbering will 
be changed from 
Top To Bottom to 
Side to Side. 

The first illustra­
tion shows the doc­
ument's pages 
numbered using the 
Top To Bottom for­
mat. The second il­
lustration shows the 
same document's 
pages numbered 
using the Side To 
Side format. 

i§O Wyndham Manor 

English Architecture 

~o- Wyndh11m Mnnor 

I 2 
% 

····1 

Showing and Printing Page Numbers 
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There are separate commands in the Print menu that allow you to display page 
numbers on the screen ("Show Page Numbers") or display page numbers on the 
printed page ("Print Page Numbers"). If a check mark appears before either of 
these commands, page numbers are currently turned on. Choosing the command 
with the check mark visible hides the page numbers. 

1. Be sure that the document you wish to refonnat Is In the active window. 

Click in the window you wish to reformat if it is not currently active. 
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2. Choose either the ''ShaN Page Numbers" or the "Print Page Numbers" command from the Print menu. 

Choosing these commands will display page numbers or enable them to be printed. 
If a check mark appears before the command, choosing it will hide the page 
numbers, which are currently displayed or are ready to be printed. 

Showing Page Breaks and Borders 

These two commands reformat the active document on the screen only. They have 
no effect on printing. The "Show Breaks" command displays lines to illustrate 
where page breaks will occur when the document is printed. If you alter the 
contents of a document after showing the page breaks, the lines may not be in the 
proper location. Always choose "Show Breaks" again after making editing 
changes. The "Show Borders" command displays a border around each page of the 
document. A check mark appearing before either command indicates that the page 
breaks or borders are already visible. Choosing the command with the check 
mark visible will reverse the command. 

1. Ciiek In the window you wish to refonnat H It is not currently active. 

The Title Bar of the document you wish to reformat should have horizontal stripes. 

2. Choase either the "Show Breaks" or the "Show Borders" command from the Print menu. 

Either page breaks or a border will appear in the active window. If they are not 
immediately visible, they can be located by scrolling. If the command appeared 
with a check mark, choosing it will hide the page break or border in the active 
document (The illustration on the previous page shows a document with both page 
breaks and borders displayed). 
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B. Printing Folders, Web Views and Documents 

106 

Once you have formatted the current window using the commands 
discussed in Subsection A. above, you are ready to print the active 
folder, Web View or document. You can only print the contents of one 
window at a time. Documents must be in an open window to be 
printed. If you select an icon without opening it and then pick "Print," 
you will print out the active window, which in this case is a folder with 
an icon highlighted in it. The procedure for printing folders, webs and 
documents is explained below. 

1. Click In the window containing the material you wish to print If It Is not active. 

The window should have horizontal black stripes. 

2. Pick the "Print .. " command from the Print menu. 

A dialog box will appear. 

L8SerWrlter <LaserWrlter> v3.1 u OK B 
Coples:jiMI Pages:® All 0 From:OTo:LJ (Cancel) 
Couer Page: ® No 0 First Page 0 Lnst Page ( Help ) 
Paper Source: ® Paper Cassette 0 Manual Feed 

The illustration shows the Print dialog box with its default settings. 

Note: The "Cover Page" option does not work in this version of IRIS Intermedia. 
The printing of a cover page is based on the configuration of your printer. 

3a. To change the number of copies to be printed, type In the number of copies you would llke to print. 

The new number will replace the number "1" in the "Copies" field. 

3b. To change the Paper Source to "Manual Feed," click on the appropriate button In the bottom llne of the 
dialog box. 

If you need more information on using the Manual Feed function, click on the 
"Help" button on the bottom right of the dialog box. 
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4. To print part of a documen~ either press the Tab key or click in the "From" field. 

You will now have a flashing insertion point in the "From" field. You need only 

use the "From" and "To" boxes if you wish to print fewer than the full number of 

pages. 

LaserWriter <LaserWriter> v3.1 II OK ~ 

Coples:Ll Pages: 0 Rll @From:Qro:LJ (Cancel) 

Couer Page: @ No O First Page 0 Last Page ( Help ) 

Paper Source: @ Poper Cassette 0 Manual Feed 

5. Type In the number of the first page you wish printed. 

If the document begins with a page number other than one, you should type in the 

page number of the first page you want printed. For example, if your document 

begins with page 1 7 and you wish to start printing at the fifth page of the document, 

you should type 21 rather than 5. 

LoserWriter <LoserWriter> v3.1 H OK ~ 

Coples:Ll Pages: 0 Rll @ From:LJro:LJ '::(=c=a=nc::e::I ~) 

Couer Page: @ No 0 First Page 0 Last Page [ Help ) 

Paper Source: @Poper Cossette 0 Manual Feed 

6. Press the Tab key or click in the "To" field and type in the page number of the last page you want printed. 

Pressing Tab or clicking in the "To" field will move the flashing insertion point. 

The page number you type will now appear in this box. If you only wish to print 

one page, type the same number in the "To" box that you typed in the "From" box. 

LHerWriter <LaserWriter> ... , 
========'="====-=====================================~v~~~· ==.= OK 

Coples:Ll Pages: 0 All @ From:LJro:LJ (Cancel) 

Cuiiei Page: @ No 0 fir~t Pege 0 lest Pege 
L Help J 

Paper Source: @ Poper Cossette 0 Manual Feed 

The first illustration shows the format for printing one page of a document. 

(Actually, for documents that are one page long, you don't have to fill in the 

"From" and "To" boxes.) 

LtiserWrlter <LoserWrlter> v3., 

coples:Ll Pages: 0 All @ From:EJro:EJ (Cancel) 

Couer Page: @ No 0 First Page 0 Lost Page ( Help ) 

Paper Source: @Paper Cassette 0 Manual Feed 
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The second illustration shows the format for printing only the pages numbered 
four, five and six in the current document. 

7. Ciiek on the "OK" button to begin printing. 

A dialog box will appear informing you that IRIS Intermedia is preparing the 
image data. If you wish to stop the printing process at this stage or while you still 
have the previous dialog box, click on the "Cancel" button. If you do not cancel the 
printing, the document will be printed when the dialog box disappears. 

Preparing image data. 

( 1)1( ) ( Cancel ) 
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Ill. USING INTERWORD 

InterWord is a text processing application that runs within the IRIS 
Intermedia system. It is used for creating and editing text documents. 
Formatting of text in the InterWord application is based on the concept 
of styles. Each unit of text (from one carriage return to the next) is 
known as a paragraph and can have a different style. For example, a 
typical document might have title, subhead, and indented quote styles 
associated with the various paragraphs that make up the document. 
Styles are created and edited through the use of a Ruler which allows 
you to change a variety of settings including line spacing, margins, jus­
tification and tab stops. Once a style is defined using the Ruler, the style 
can be applied to existing paragraphs or to new paragraphs. 
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1. HANDLING INTERWORD DOCUMENTS 

The methods for creating, opening, closing and saving InterWord 
documents are simple to learn and are the same for all other 
applications in the IRIS Intermedia system. If you learn to handle 
InterWord documents, you also will have learned how to handle any 
other type of IRIS Intermedia document you may encounter. 

A. Opening Existing lnterWord Documents 

Existing text documents are represented in folder and Web View 
windows by special Inter Word document icons. 

1. select an lnterWord document icon from a folder window. 

To select, place the pointer directly over the icon and click the mouse button. A 
selected InterWord icon in a folder or Web View window will be highlighted in 
black (as on the right, below). 

-. 
- II.,,·: . . . 

l@IU Joyce 

Position the pointer Click once 

2. Pick "Open" from the File menu. 

A window containing the InterWord document wi11 open. (Doubie-c1icking on an 
InterWord document icon in a folder window will produce the same result as steps 
1. and 2.) 
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B. Opening a New lnterWord Document 
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Selecting "New" from the File menu provides easy access to opening 
each of the various types of documents in IRIS Intermedia, including 
InterWord documents. 

1. Pick "New'' from the File menu. 

The "New" window will open. 

2. Select the lnterword application Icon. 

New 

@ ~ [lg 
Web folder Val Dra\rt' 

The icon will be highlighted in black. 

3. Choose "Open" from the Fiie menu. 

The InterWord application will start up, opening a new window. The window will 
contain both a Ruler and a Style Palette (see Section 3. for details on using styles). 
Initially the document will be called "Untitled." (Double-clicking on the 
InterWord icon in the "New" window will produce the same result as steps 2. and 
3.) 
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C. Saving an lnterWord Document 

It is a good idea to save your work periodically as a protection against a 
system failure. You may also want to save a copy of the text document 
you are working on. Saving a copy is a useful way to back up your work 
or to freeze a version of the document to which you can return at a 
later time. 

Saving the Current Document 

1. Pick "Save" from the File menu. 

The "Save" command will only be available if you have made changes to the 
lnterWord document. Be sure that the window containing the InterWord document 
you wish to save is active (the Title Bar should contain horizontal black stripes). 
The "Save" command will save all the changes you have made. The arrow cursor 
will turn into a wristwatch while the document is being saved. If you are saving 
the document for the first time, you will be prompted to type in a name for the 
document after which you must click on the "Save" button. (See illustration of 
"Save As" Dialog below.) 

2. Wait for the arrow cursor to return before continuing to work. 

If your document is long, it may take several seconds for the system to save it. 
Wait until you see the arrow cursor before trying to edit the document. 

Saving a Copy of the Current Document 

1. Pick "Save As" from the Rle menu. 

Be sure that the window containing the lnterWord document you wish to save is 
active (the Title Bar should contain horizontal black stripes). Choosing the "Save 
As" command will bring up a dialog box asking you to type in a name for the copy 
of the current document. 

Snue this document H: 

Stlue Cancel 

Note: If you have made changes to your current document since it was last saved, 
the changes will only be saved in the copy of the document and not in the original. 
Save the document before choosing "Save As" if you want the changes saved in 
both versions. 

3. Using lnterWord Handling lnterWord Documents 115 



2. Type In a name for the copy. 

The title of the document will be selected when the dialog box appears. Any typing 
you enter will replace the selected text. If you wish to use part of the title (as in the 
example shown), do not type immediately. Instead, use the editing techniques 
described in Section 2. Editing Text. 

Snue this document ns: 

!Joyce Works Bnckup 

Cnncel 

3. Ciiek on the "Save" button. 

The "Save As" dialog box will close, a new InterWord icon with the name just 
entered will appear in your current folder, and the copy will appear in the open 
InterWord window. The original document will close. 

D. Closing an lnterWord Document 
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After you are finished examining or editing a document, it is a good 
idea to save it and put it away. When you close an InterWord 
document, it will return to its icon representation. 

1. Pick "Close" from the File menu or cllck In the window's Close Box. 

Be sure the text document you wish to close is in the active window. Closing the 
document will close the window and return the document to its icon 
representation. If you have made changes to the document before closing it, you 
will be asked if you would like to save those changes. 
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2. EDITING TEXT 

The methods and techniques described in this section for text editing 
can be applied in any other IRIS Intermedia application that allows 
you to edit text. 

A. Entering Text 

Before typing in text, you must set an insertion point. This vertical line 
indicates the location at which you will add new text. 

1. Position the pointer at the location at which you want to enter new text 

Text will always be inserted to the right of the insertion point. 

2. Cilek the mouse button once. 

This will set an insertion point, which is a thin blinking vertical line. If you 
click in a new location, the insertion point will move to that location. 

3. Type in characters using the keyboard. 

The characters you type will appear at the insertion point. All the characters to the 
right of the insertion point will be shifted right to accomodate the new text. To add 
text at a different point in the document, simply move the pointer to the desired 
location in the text and create a new insertion point. 

:o Joyce 
James Joyce Q 

L.: Alld ... ,of ~o~cde's wo~k is (e!~ehid to ~~ lif~ hd> '"~~ =
0

1_, __ ,1.: .•. 1.' ... 1.: .•. 1_.·''·'.• 

1ue.n S1up, ir.a t.."1.t or uc.gmci.~ o. •s ree.w.ug we.s gnst to lllS _ 

artistic mill His whole life seemed one long artistic project and, 
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B. Selecting Text 

In order to change text in any way, it must first be selected. For 
example, if you would like to change an existing word into boldface or 
italics, or if you simply wish to correct a spelling error, you must first 
select the text. The simplest method of selection is by dragging, which 
allows you to select any number of characters. The sections following 
this one detail all the operations you can perform on text once you have 
selected it. 

Selection by Dragging 
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1. Press and hold down the mouse button to set an 
insertion point 

This position marks the beginning or end 
of a set of characters you wish to select. 

2. Without releasing the mouse button, drag the mouse to 
highlight the desired text 

When you drag the mouse, the text between 
the insertion point and the moving cursor 
will become highlighted in black. As you 
drag the mouse, the extent of the selected text 
changes. 

Note: You can also select a whole word by 
double-clicking on it. 

3. Release the mouse button. 

Releasing the mouse button sets a selection. 
The text encompassed in the selection (the 
text which is highlighted in black) can now 
be changed in a number of ways. You can 
always change the selection by pressing the 
mouse button and dragging to a new 
location. 

Editing Text 

Joyce 
Jam.es Joyce 

Set an insertion point 

~D Joyce 
James Joyce 

Drag up 

~D Joyce 
Jam.es Joyce 

All of Joyce's work. is intimatei 
related to his life 

Drag down 
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